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1 Ruskin software
Ruskin is the only tool you need to manage all your RBR instruments and measurement data. It is available for Mac® and 
Windows® PC (Ruskin Desktop), as well as for iOS® and Android™ (Ruskin Mobile). 

Use the Ruskin software to do the following:
 Configure, schedule, and enable multiple instruments
 Estimate your deployment times
 Download your data after logging
 View your datasets graphically
 Export your data in various formats
 Analyse your data
 Change the calibration coefficients for your instrument
 Perform user calibration
 Contact RBR

RSK files generated by Ruskin contain raw measurement data, firmware and software versions, dates and times, 
sampling settings, power settings, measured and derived parameters, errors and events, other diagnostic information. 
They can be read directly in Matlab, or exported to Excel, OceanDataView®, or text files. 

Find Ruskin software for Mac and PC on the USB stick included with your instrument, or visit the RBR website to 
download the latest version. 

Go to the Apple App store or Google Play for Ruskin Mobile. 

The most recent software updates, release notes, Ruskin user guides, instrument guides, and quick start guides are 
available from the Help menu in Ruskin.

https://rbr-global.com/products/software/
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2 Ruskin interface
Ruskin software has a user-friendly interface which consists of a Toolbar and three main windows: Navigator, 
Properties, and Plot.

In the Navigator window, you will find the list of instruments connected to Ruskin, as well as MLM and winches (if 
applicable), and datasets. 

When an instrument on the list is selected, the Properties window displays four tabs with information related to this 
instrument: Configuration, Information, Calibration, and Parameters. Use these tabs to configure your deployment, 
check the calibration certificates, and verify your parameters.

The data plot will appear in the Plot window below if the realtime option is available and selected for this instrument, 
or if you click the Fetch button (green triangle on the far right of the toolbar). 

Click-and-drag window tabs to rearrange the windows within Ruskin, or move a window outside of Ruskin. Hover over a 
side of a window, and when the cursor becomes a two-way arrow, move it to adjust the window size. 

Click the Minimise button in the top right corner to minimse a window. For example, you can close the Navigator
window to have a better view of the Properties. The closed window icon will appear on the sidebar. Click the Maximise
button above the closed window icon to re-open it. 



RBR#0006105revQ 8

Double-click a window tab to maximise that window, and double-click the tab again to return it to the original size. 
Alternatively, use the Minimise and Maximise buttons. 

The Toolbar at the top left above the Navigator window has four dropdown menus. If you are using a Mac computer, it 
appears as follows:

On a Windows PC, the Toolbar looks slightly differently:

The rest of the interface is the same between the two systems. 

2.1 Ruskin / Options
On your Mac, go to the Ruskin dropdown menu to access information on current software version, set up your 
preferences, or quit Ruskin. Note that the rest of the options on this dropdown menu depend on your operating system 
and are external to Ruskin. 

On your Windows PC, use the Options dropdown menu to set up your preferences. 

2.2 File

Go to the File dropdown menu to open or close a 
dataset, export your data, and see the list of available 
datasets. The Datasets menu in the Navigator windows 
duplicates some of these options for convenience. 

When you restart Ruskin, it returns to its original layout. 
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2.3 Instruments

Go to the Instruments dropdown menu to simulate an 
instrument, update your firmware, set up automatic 
tasks, or take advantage of the utilities. 

The Instruments menu in the Navigator windows duplicates some of these options for convenience. 

2.4 Help

Go to the Help dropdown menu to access the latest 
release notes and technical documentation, provide your 
feedback, check for updates, or to add a beta feature. On 
Mac, you can also use the Search option. 

The Utilities option is a support tool. Contact 
RBR before using it. 

mailto:support@rbr-global.com


RBR#0006105revQ 10

3 Installation
Ruskin is the only piece of software you need to operate your RBR instruments. RBR releases Ruskin software versions 
compatible with Mac and PC (Ruskin Desktop), as well as with iOS® and Android™ (Ruskin Mobile). 

Install the Ruskin Mobile app on your mobile device by going to the Apple App store or Google Play. 

Follow the steps below to install Ruskin Desktop on your computer. 

3.1 Install Ruskin on PC
You can install Ruskin on a PC that runs the Windows 7, 8, 8.1, or 10 operating system.

The minimum requirements for Ruskin are:

OS = Windows 7

Processor speed = 1.4GHz

RAM required = 2GB

Display resolution = 1024x768 recommended

HDD space for installation = 2GB

The instruments use a USB interface to communication with Ruskin.

Steps

1. Connect the USB stick included with your instrument to a port on your computer.
2. Navigate to the Ruskin Installation folder and double click on the file RuskinSetup.exe .

3. Follow the installation wizard. By default, Ruskin will be installed to C: \RBR
4. At the end of the installation, you will see a prompt asking, “Would you like to install the logger driver at this 

time?”
5. Click Yes to install the drivers

A shortcut to Ruskin will appear on the desktop and in a Start menu folder.

3.2 Install Ruskin on Mac
You can install Ruskin on a Mac running OS X 10.12 (Sierra) or later.

Steps

1. Connect the USB stick included with your instrument to a port on your adaptor.
2. Navigate to the "OSX" folder and double-click on the file Ruskin.dmg .

Realtime sensors will not require USB drivers to operate, they are only required for our standard and compact 
instruments.

You may need to run the setup application as an administrator to install the driver correctly.

The most recent version of Ruskin software can be found at https://rbr-global.com/products/software.

Always use the default Applications folder as the working directory.

https://rbr-global.com/products/software
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3. When the disk image window opens, drag the Ruskin icon into the Applications directory and wait for the copy 
to complete. An application named "Ruskin" will appear in the Applications folder.

4. Right-click on the icon, and select Open.
5. A dialogue box will prompt you to authorise the opening of Ruskin. 

6. Drag the Ruskin.app  application to the Dock

3.3 Update Ruskin
To take advantage of new features and bug fixes, ensure that you are using the most recent version of Ruskin. 

 Find the most recent version of Ruskin at https://rbr-global.com/products/software.
 Receive an automatic notification about a new release when you start the application.
 Check from within Ruskin by navigating to Help > Check for updates. 
 Send an email to support@rbr-global.com, subject: "Ruskin update request", and ask us to add you to the 

mailing list. You will receive an email as soon as the new version is released. 

If you have a broadband connection, simply follow the installation instructions on your computer. Otherwise, request a 
USB stick from RBR.  

3.4 Uninstall Ruskin
Uninstall Ruskin only if you no longer need to manage RBR instruments from your computer.

It is not necessary to uninstall the older version of Ruskin before installing the newer version. The installation program 
deletes the older files before installing the newer ones. For more information, see Updating Ruskin.

Uninstall Ruskin on a PC, Windows 7, 8, 8.1, or 10
1. Go to Start > Control Panel > Programs.
2. Under Programs and Features, click Uninstall a program.
3. Find Ruskin on the list.
4. Click Ruskin to highlight it.
5. Click Uninstall.

Uninstall Ruskin on a Mac, OS X 10.12 or later

Move the Ruskin application from Applications to the Trash.

You may need to navigate to System Setting > Privacy & Security to Allow applications from “App Store to 
Known Developers” to complete the installation.

It is not necessary to uninstall the older version of Ruskin before installing the newer version. The installation 
program deletes the older files before installing the newer ones. It does not delete any Ruskin data files or log 
files.

Removing Ruskin will not delete your data files or your diagnostic logs.

https://rbr-global.com/products/software
mailto:support@rbr-global.com?subject=Ruskin%20update%20request
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4 Support
You can get in touch with RBR in several different ways:

 Send us an email.  For technical questions, use support@rbr-global.com, and for general inquiries, info@rbr-
global.com.

 Contact us via the website at https://rbr-global.com/about-rbr/contact-rbr.
 Call us at +1 (613) 599-8900.
 Send us a bug report from within Ruskin itself. 

The Help menu on Ruskin offers access to technical documentation, feedback forms, and software updates.  On Mac, 
you can also search for Ruskin menu options. 

4.1 Search on Mac
If using a Mac computer, you can take advantage of the Search option.

In the Search field under Help, type in a word, part of the word, or even a single letter to open a list of matching items.

The top half of the list pertains to Ruskin, while the bottom part comes from the Mac environment.

When experiencing an issue, look for a solution under the Help menu before contacting RBR. 

mailto:support@rbr-global.com
mailto:info@rbr-global.com
https://rbr-global.com/about-rbr/contact-rbr
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Scroll down the Ruskin list and select an item to locate.  Ruskin will open the toolbar menu and point to the option in 
the dropdown menu. 

You can execute the located option right away.

4.2 Release notes
Click on Help > Release notes to open the Welcome window. It will outline new features, improvements, and bug fixes 
associated with each release version.

Click the link at the bottom left to see the full history of the release notes. The link will take you to the RBR support
page.

Alternatively, scroll down to see brief recaps of the release notes from all previous versions. 

Click the x to close the Release notes window and return to the Navigator mode. 

https://docs.rbr-global.com/support/ruskin/release-notes
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4.3 Documentation

Click on Help > Documentation to open the menu tree. 
Browse through a variety of guides available for 
instruments and accessories. 

Please note that you can always access the most current revisions of RBR documents on the RBR website.  

4.4 Comment on Ruskin
There is an advantage to sending a bug report from within Ruskin because this allows you to include the diagnostic 
logs, RSK datasets, screenshots, and any other files that could help us reproduce the problem and find the solution as 
quickly as possible. Follow the steps below. 

Steps

1. Click on Help > Comment on Ruskin... . The 
Feedback to RBR form will appear.

2. Enter your identification information. 
3. Enter a brief summary of the problem. 
4. Provide a detailed description (serial number for 

the instrument, overview of the problem, 
deployment details, initial tests, and, for software 
bugs, steps to reproduce the issue)

5. Include any attachments, if required. 
6. Verify all the information entered and click 

Submit. 

.

https://rbr-global.com/support/documentation/
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4.5 Check for updates
Click on Help > Check for updates to search for the latest software version. 

If your software is up-to-date, no further action will be required. 

If an update is found, Ruskin will offer to install it. Follow the prompts. Restart Ruskin for the updates to take effect.

4.6 Feature codes
Sometimes, RBR may release new features to certain users only, as a beta trial. This includes:

 Features in early development  
 Features supporting a new product, in preparation for the product launch
 Features requested by a specific customer

Usually, the goal is to get feedback and improve the feature before its official release. Contact your sales representative 
or RBR support team at support@rbr-global.com if you have questions about your feature code.
Steps

1. Click on Help > Feature codes...
The Feature codes window will appear. 

2. Enter the feature code provided by RBR.
3. Click ADD.

If the code is correct, Ruskin will save the feature in the local database and enable it. In most cases, you will have access 
to the new feature immediately, without restarting Ruskin. Otherwise, you will receive any additional instructions at the 
time when you receive the feature code.  

Errors
1. The feature code is not valid.

This error may indicate the code was entered incorrectly or it is not compatible with the current version of 
Ruskin.

2. The feature code is already enabled.
This error may occur when another user has already activated this code. 

mailto:support@rbr-global.com
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5 Quick start - Ruskin Desktop
Ruskin Desktop version is designed for computers and laptops. It generates dataset files which include raw 
measurement data, firmware and software versions, dates and times, sampling settings, power settings, measured and 
derived parameters, errors and events, calibration coefficients, and diagnostic information, offering the fullest Ruskin 
experience. 

5.1 Select Desktop on Ruskin
By default, new deployments started from a laptop or desktop computer are set to the Desktop storage format and 
nothing needs to be adjusted. However, if the instrument has Wi-Fi, it will have Mobile selected by default from the 
factory, facilitating faster downloads.  When you start a deployment from your mobile device, the storage format 
defaults to Mobile. 

You may prefer your datasets to contain raw data with the ability to change calibration coefficients. In this case, go to 
the Configuration tab and open the Storage dropdown menu under Options.  Select Desktop.  

Ruskin Desktop can download datasets created in either Mobile or Desktop format. However, when Mobile is selected, 
you will not be able to edit calibration coefficients and recalculate the data.  

5.2 Simulate an instrument
Ruskin can simulate most instruments and sensors that RBR produces. We recommend that you experiment with 
different simulated options before enabling a schedule for your actual deployment. This practice will also help you 
become more familiar with how an RBR instrument interacts with Ruskin and how to configure its settings and 

The raw data is not stored when operating an instrument with data storage format set to Mobile. The RSK file
will only contain the calibrated data. 

You cannot change between Desktop and Mobile storage formats during the same deployment. Stop your 
deployment, change the setting, then start a new deployment.



RBR#0006105revQ 17

features. Work with simulated instruments the same way as you work with a real RBR instrument, configuring, 
calibrating, and fetching data.

Steps

1. From the Instruments menu, click Simulate an 
instrument. 

The Configure simulated instrument dialog box will 
appear.

2. Click your instrument family and make your 
selections. 
Within the Standard instruments family, Ruskin 
will identify the type of instrument to simulate 
based on the number and type of channels you 
include. If you select only one channel, Ruskin will 
simulate the RBRvirtuoso3.  If you select more 
than five channels, it will become the 
RBRmaestro3. The name of the instrument and its 
generation will be displayed in the top section of 
the dialog box, for example, "Late 2017 - 
RBRconcerto3 C.T.D". 

3. Click OK to proceed.
4. Your instrument will appear under Instruments in 

the Navigator view. Simulated instruments will 
have a prefix "sim" in the front of their name.

Currently, you cannot enable simulated instruments or download their data. For more information, see Deploy 
your instrument.

Depending on the instrument selected, the 
Options dropdown menu may contain | fast 
sampling rates, | tide and | wave variants, tilt, or 
no options at all (in that case, the menu will be 
greyed out).
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The instrument properties will be displayed on the right, 
under four tabs.

 The Configuration tab displays status, clock, 
sampling mode and speed, serial connection 
details, power options, and deployment estimates 
based on these parameters

 The Information tab includes general details, 
such as the instrument model, generation, serial 
number, firmware version, power source, battery 
status, and the channels

 The Calibration tab allows access to the current 
calibrations for each channel in the instrument

 The Parameters tab outlines default values used 
by the sensor when performing computations and 
derivations

5. Familiarise yourself with the instrument by changing configuration options and comparing deployment 
estimates. Select the desired configuration using the dropdown options or entering the values manually in the 
fields provided.  For simulated instruments, the Plot window will remain empty unless you click the Fetch
button . 

6. Manage multiple instruments by switching between them in the Navigator window. 

5.3 Deploy your instrument
Before using your RBR instruments, you may want to experiment with different options by simulating your instrument
on Ruskin.

When you are ready to use your physical RBR instrument, follow the steps below to ensure that you measure exactly 
what you want on the first attempt. 

Steps
 Remove the battery end-cap. See "Opening and closing the instrument" section in the corresponding RBR 

Instrument Guides for more details. The Guides are available on Ruskin under Help > Documentation. 
 Locate the USB-C port. For most standard instruments, it is inside the housing, next to the battery cover. For the 

RBRquartz³ BPR | zero and RBRquartz³ Q | plus, it is inside the end-cap.
 Plug one end of the USB cable (USB-C to USB-C, provided with your instrument) into this port and the other, in 

the USB port on your computer.
 The instrument will appear in the Navigator view after a few seconds. The properties for the instrument will be 

displayed in the Properties window, grouped under four tabs: Configuration, Information, Calibration, and 
Parameters.

 If you are using the instrument for the first time, you can use either the default preferences or specify your own. 
For more information, see Preferences > General. You can change them at any time.

 Click the instrument you want to use. Verify that it contains the expected sensors under the Information tab. 

 Click the Calibration tab to view or modify calibration coefficients.
 Click the Configuration tab and go to the Sampling section to select the mode and speed of measurements.  

To remove a simulated instrument from Ruskin, right-click it in the Navigator window, and select Disconnect 
from instrument. You can also use the Instruments menu.
 Alternatively, simply close its Plot tab by clicking the X. The instrument will disappear from the list.
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 Click the Enable button at the bottom of the Configuration tab to take samples according to the schedule that 
you specified.
Your deployment will continue until the battery runs out, the memory is full, or you stop your schedule 
manually. 

 When your deployment stops, click the Download... button at the bottom of the Configuration tab to transfer 
all the sampled data from the instrument to your computer. For more information, see Download.
As soon as you download a new dataset, it will appear in the Navigator window. Refer to Datasets for details on 
managing and analysing your data.

5.4 Recover your instrument and download data
When deployment is complete, recover your instrument and follow these steps to download your data.

Steps
1. Start Ruskin.
2. Carefully remove the battery end-cap. See "Opening and closing the instrument" section in the corresponding 

RBR Instrument Guides for more details. The Guides are available on Ruskin under Help > Documentation. 
3. Locate a USB-C port inside of the instrument.
4. Plug one end of the USB cable (USB-C to USB-C, provided with your instrument) into this port and the other, in 

the USB port on your computer.
5. The instrument will appear in the Navigator view after a few seconds.

Ruskin will allow a deployment to run until the instrument can no longer sample. This could be due to a full 
memory or due to power supplies being exhausted.  It will display the estimated battery usage and storage 
capacity based on the parameters you enter. The green widget next to End will indicate the number of days 
your instrument would be sampling, along with the icon representing the limiting factor, battery or memory.
Carefully consider this information before you enable a deployment schedule. For more information, see 
Schedule.

If you want your data streamed or fetched, specify these preferences before you enable the schedule:
1. 

 Click the Configuration tab and select the streaming option from the Realtime dropdown menu 
(Serial or USB).

 To see live data sampled every few seconds, click the Fetch button on the far right of the toolbar 
above the Plot view, without enabling the schedule. 

 To start streaming, click Enable. The data will immediately appear in the Plot window below.
The instrument does not store streamed or fetched samples, but Ruskin will record them in the 
realtime RSK file.  

To restore a closed connection to an instrument on Ruskin, click Instruments in the Navigator window. A list 
of all instruments physically connected to your computer will appear in the Properties window.
Find your instrument and deselect its checkbox, and then select it again.
Your instrument will re-appear in the Navigator window.

Flooded instruments may be under pressure and opening them may be dangerous. Take precautions when 
opening an instrument after deployment.
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6. Under the Configuration tab, click Download... . See Download for details.

7. Save the file to your local drive. See Preferences > General on steps to set up your default location. 
8. Evaluate your data. See Analysis for details.

Disconnect from your instrument

To disconnect an instrument from Ruskin, right-click it in the Navigator window, and select Disconnect 
from instrument. You can also use the Instruments menu.

 Alternatively, simply close its Plot tab by clicking the X. The instrument will disappear from the list. Please note that 
you will be able to reconnect to it at any time because Ruskin remembers the port of a plugged instrument.

Reconnect to your instrument

To restore a closed connection to an instrument on Ruskin, click Instruments in the Navigator window. A list of all 
instruments physically connected to your computer will appear in the Properties window, under the Connections tab.

Find your instrument and deselect its checkbox, then reselect it again. Your instrument will re-appear in the Navigator
window.

Remove your instrument

To completely remove your instrument from Ruskin, unplug it from your computer. 

Alternatively, deselect the checkbox next to your instrument, and Ruskin will disable transport to its port. 
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6 Quick start - Ruskin Mobile
Ruskin Mobile is a light version of Ruskin, with all the essential functions needed to manage deployments, and with the 
added advantages of a smart phone such as augmenting data with GPS tracking, displaying live data and uploading to 
the cloud. Ruskin Mobile connects to Wi-Fi enabled RBR instruments and works on iPhone®, iPad®, Android™ phone, 
and Android™ tablet. Install the Ruskin app on your mobile device by going to the Apple App store or Google Play.

6.1 Select Mobile on Ruskin
By default, new deployments started from a mobile device are set to the Mobile data storage format, and nothing 
needs to be adjusted.  

However, when you start a deployment from your laptop or desktop computer, it defaults to the Desktop format which 
will limit your abilities to view the dataset on the mobile device.

On some occasions, you may set up your instrument from the laptop with the intention to view the dataset on your 
mobile device afterwards. In this case, go to the Configuration tab and open the Storage dropdown menu under 
Options.  Select Mobile.  

With the Mobile data storage format selected, you will be able to track your instrument by adding the GPS location of 
your phone or tablet to the dataset. The RSK file will store data already calibrated, facilitating faster downloads over the 
Wi-Fi.  

Ruskin Mobile can download datasets created in the Desktop format. However, features such as charting will not be 
available.  

The raw data are not stored when operating an instrument with the storage format set to Mobile. The RSK file
will only contain the calibrated data, which prevents re-processing the dataset with new calibration 
coefficients. 

You cannot change between Desktop and Mobile storage formats for the same deployment. If started in 
Desktop mode, there are two options:

1. Stop the current deployment, change the setting, then start a new deployment.
2. Continue the same deployment in Desktop mode, without the ability to view charts. 

You can still download your dataset, archive it to Dropbox or another sharing destination, and then use 
Ruskin Desktop to display it on your computer.
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6.2 Connect to your instrument
RBR instruments with a built-in Wi-Fi module have the WI-FI READY icon on the end-cap and can connect to mobile 
devices. 

.

The Wi-Fi module needs to be enabled at the time of purchase. Contact RBR if you have any question about this feature.

Steps

1. Android
a. Twist the instrument end-cap any direction to activate the Wi-Fi. The Wi-Fi will stay on for 60 seconds, 

waiting for you to connect. .
b. Open Ruskin and tap Search for instruments.

If only one instrument is detected, Android will automatically connect and begin downloading the latest 
dataset. 

2. iOS
a. Twist the instrument end-cap any direction to activate the Wi-Fi. The Wi-Fi will stay on for 60 seconds, 

waiting for you to connect. 
b. Open Ruskin and tap the convenience button on the landing page. The app will take you to the Settings

page, from where you will navigate to Wi-Fi. 
The instrument will create its own SSID and appear under available Wi-Fi networks. Its name will be the 
RBR serial number, for example, RBR 060286. 

Any given instrument may be connected to only one device at a time. 
Connect to your instrument and set up all deployment parameters before submerging it. 

Twisting the end-cap to the RUN or PAUSE position will activate the Wi-Fi.
However, twisting to the PAUSE position will also pause the instrument.

mailto:support@rbr-global.com
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c. Tap the instrument SSID name to connect and wait for a blue checkmark to appear on the left of the Wi-Fi 
network.
A message "No Internet Connection" will appear below. It has no effect on using Ruskin Mobile to 
manage deployments and refers only to the inability to browse websites while connected to the 
instrument. 

.
d. Return to Settings, then to the Home screen. 
e. From the Home screen, tap the Ruskin app icon . Ruskin Mobile will automatically connect to the 

instrument.

There are four views on Ruskin Mobile: Instrument, Datasets, Locations, and Settings, accessible via the toolbar at 
the bottom of the screen.

When first connected, Ruskin Mobile will open the Instrument view of the app. Use this tab to set up and manage your 
deployment. 

The Wi-Fi is disabled after 60 seconds of inactivity. Twist the end-cap to RUN or PAUSE to re-activate the Wi-Fi.



RBR#0006105revQ 24

Tap Datasets to access local datasets and charts, upload datasets to your Dropbox account or another sharing 
destination, and (optionally) delete archived datasets. 

Tap Locations to track your instrument during deployment. 

Tap Settings to manage your deployment preferences and share feedback or contact the support team. 

6.3 Deploy your instrument

The Ruskin Mobile screen is divided into several areas where current parameters are displayed, and includes three 
operating buttons. There is a toolbar at the bottom of the screen, with four views:  Instrument, Datasets, Locations, 
and Settings.

When connected to an instrument, the Instrument view contains information about your instrument and its 
deployment.
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Status

The top of screen shows the name and serial number of the instrument, followed by its status: 
 Number of samples taken 
 Logging state (ON or OFF)
 Sampling rate

When the logging state is shown as ON, the instrument is 
logging data.
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When the logging state is shown as OFF, the deployment 
is paused but still in progress.

 A deployment can have only one sampling rate, thus you cannot change it when logging is just paused.

To adjust the sampling rate, you have to stop the deployment using the red STOP button. A message "Deployment 
stopped" will be displayed, and the sampling rate field will become editable. However, you cannot resume the same 
deployment after stopping it. After changing the sampling rate, you will have to start a new deployment.

Realtime data

A sparkline chart shows the last 50 readings for each of 
the measured channels (or the last 150 readings when 
using a tablet). These are typically out-of-water samples 
and serve to provide realtime feedback from the 
instrument.

To view charts of the full deployment, tap the light blue 
VIEW button.

Geotagging

Your instrument does not have a GPS, but its location 
information may be available depending your phone/
tablet tracking capabilities.

Whenever the Ruskin App connects to an instrument, it 
automatically logs its location at that moment. Even if 
the boat moves away from the starting point during 
download, the initial location will be captured in the 
dataset.  Should a more accurate location fix be attained 
within the first minute after connection, those 
coordinates will be used instead.

The LAST TAGGED LOCATION data indicate when the last GPS coordinates were added to the dataset.

Once a deployment has been stopped, it cannot be resumed.
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As the app uses GPS, a clear view of the sky will allow a more accurate waypoint, rather than downloading inside a ship 
cabin, for example. To conserve the battery life of your phone, GPS tracking only occurs when the Ruskin App is open or 
when you are recording a track of your location.

It can take a few moments after opening the app to get an accurate location fix. When GPS is working well, an accuracy 
of around 5 metres can be expected. 

Tap the purple TAG button to log the CURRENT LOCATION data manually. The last tagged location will be updated to 
indicate the coordinates and accuracy of the manual GPS waypoint fix.

Both types of waypoints described (manual tags and those taken automatically on download) can be seen plotted on a 
map in the Locations tab.

Channels

Scroll to the bottom of the Instrument tab to view 
measured and derived channels, along with their units of 
measurement.

The coloured circle to the left of each channel indicates 
the sparkline colour representing the latest readings 
from that channel.

Deployment

The red button in the bottom right corner reads either 
START or STOP, depending on whether a deployment is 
in progress.

Tap the START button to begin a new deployment. When 
a new deployment is started, the data on the instrument 
will be erased.

Tap the STOP button to end the current deployment. 
Once a deployment has been stopped, it cannot be 
resumed.

One dataset is created for each deployment. Deployments are typically long-running and consist of many sampling 
periods (activated by twisting the end-cap to RUN) and paused periods (activated by twisting the end-cap to PAUSE). 
Each deployment can only have one sampling rate, and it cannot be changed while logging is just paused.  To change 
the sampling rate, stop the deployment. 

Use the twist activation feature to pause deployment if you intend to continue with it later. 
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6.4 Access datasets and charts
 When connected to an instrument, the Datasets view allows access to local and archived datasets.

The Local Datasets list includes the datasets stored on your mobile device after they were downloaded from connected 
instruments. You can view charts for these datasets on your device. 

To save space, you may choose to upload your datasets to Dropbox. These datasets will be on the Archived Datasets
list. If you have not set up your Dropbox and are using other ways to upload datasets from your device, the second list 
will not appear. 

When the deployment is stopped, twisting the end-cap to either RUN or PAUSE will activate the Wi-Fi, but the 
instrument will not vibrate as it is not sampling. 

 By default, the datasets will be automatically removed from your device once they are uploaded to Dropbox. 
Thus, you cannot view charts for archived datasets. To change this preference, go to the Settings tab. 
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Sample datasets, captured from real deployments, are 
available to demonstrate the features of the Ruskin app.

If a dataset is in Desktop format instead of Mobile, its 
icon will include an exclamation mark. You will not be 
able to view charts for this dataset. 

Tap GPS Track to display raw GPS tracking data. 

Every time the instrument comes out of the water, Wi-Fi automatically turns on and your mobile device records that 
location. The Ruskin mapping feature uses these GPS coordinates to plot the route of your instrument on the map. 

Uploading and sharing datasets

On iOS, swiping to the left on an item in the Datasets list 
will reveal several operations that can be performed on 
that dataset: Info, Share, Delete. On Android, long-
pressing the item reveals the equivalent context menu.

The Share option shows a context menu of the available for that dataset. What these are, depends on the apps you 
have installed on your phone, but a number of options come without additional apps. On iOS these include sharing by 
email, AirDrop, and saving to Files (as of iOS 11). To see your cloud drive (Google Drive, Baidu, Box, Microsoft OneDrive, 
iCloud, Dropbox, etc.) as a sharing destination, you need to install that app. 

Sharing options are only available for local datasets.
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Dropbox

There are additional features available for Dropbox 
sharing which, incidentally, do not require the Dropbox 
app to be installed.

To enable Dropbox integration, you must sign in to 
Dropbox. The option for this is at the top of the Settings
tab.

Press the Cloud button in the top right corner of the Datasets tab to bulk upload all your local datasets. As the datasets 
upload, the icon will transition from an upwards arrow to a checkmark.

By default, the datasets will be automatically deleted from your device once they are uploaded to Dropbox.  To change 
this preference, go to the Settings tab.

Charting

Tap on a dataset on the Local Datasets list to view its charts. 

The charts are separated into casts (one cast per page). Each time the instrument descends and ascends again is 
considered to be one cast, and a new chart is created for each. Swipe left and right to view the chart for each cast. In the 
example shown, the dataset includes 10 casts. 

The instrument determines the start and end of a downcast by depth (pressure) readings, and thus only a single chart 
will be created when testing the out-of-water samples.  

In portrait orientation, channel data is plotted by depth, 
and only downcast data. The upcast data is omitted.

When the instrument sensors face downwards, the 
downcast provides the most accurate data, while the 
upcast data can be subtly impacted by the turbulence 
from the leading instrument housing on the ascent.

Tap on the multi-coloured caption under the plot to open 
the legend with units of measurement. Use the toggle 
buttons to select which channels to display on the chart. 

To view charts for the currently connected instrument, go to the Instrument view. 

When viewing out-of-water samples, the 
downcast chart will appear like a random plot 
because there is no change in depth. 
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In landscape orientation, the channel data is plotted by time. Depth is inverted, so the bottom reading on the chart 
intuitively represents the bottom of the cast. 

Use pinch-to-zoom to zoom in and out on your data. The chart axes adjust relative to each other on zooming and 
panning around the chart. As a result, all chart series occupy the full height or width of the chart and can be easily 
compared side-by-side.

Tap on Details in the top-right corner to reveal information about the displayed cast and deployment parameters. The 
deployment data is also available in the Info context menu of the Datasets list.
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The same deployment data is also available in the Info
context menu of the Datasets list.

6.5 Track your instrument
When connected to an instrument, the Locations view allows you to display its GPS coordinates and plot profiles as 
data points on a map during deployment. This feature relies on location capabilities available on your mobile device.
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Tracking

The red button in the bottom right corner reads either START or STOP, depending on whether tracking is in progress.

Tap the red START button to start tracking. A red 
tracking banner will appear at the Locations icon in the 
toolbar. 

The first time you use this feature on iOS, you will see a 
prompt, "Allow Ruskin to also access your location even 
when you are not using the app". Select Always allow; 
otherwise, when you leave the app, tracking will cease. 

Follow your deployment on the map, or view a broader 
context by using pinch-to-zoom or panning away from 
your track. Tap the purple RECENTER button to return to 
your location. 

Tap the red STOP button to stop tracking.

Unless you tap STOP, tracking will continue for up to 24 
hours, even with the app in the background. On iOS, you 
can also interrupt GPS tracking by force-closing the app: 
double-tap the home button and swipe upwards (or, on 
iOS devices with faceID: swipe upwards and pause in the 
centre of the screen, then swipe up on the app to be 
closed). 

GPS track files

A waypoint is automatically added to the RSK geodata table whenever the instrument connects and also whenever you 
tap the purple TAG button in the Instrument view. Raw GPS data is saved as a GPS track file in the GPX format.

When a deployment is in progress, its track will be displayed on the dropdown menu as Active track. All previously 
recorded tracks are displayed as a GPS Track with time and date listed below. 

Tap GPS Track in the dropdown to open a track file. You 
can also access and manage them from the Datasets
view. 

The Ruskin tracking feature relies on location capabilities of your mobile device. When the boat is towing the 
instrument, the phone and the instrument are at the same location at any given time. The app knows where 
the instrument was for each sample and adds this information to the dataset, thus ensuring continuous 
tracking. 

To save battery power, stop GPS tracking when you stop deployments.
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When you open a previously recorded track in the Locations view, the current location details disappear from the 
header along with the red STOP button and blue RECENTER buttons. This does not affect the recording of the current 
track. To view current location stats or stop tracking, open the dropdown menu and tap Current Track.

One track creates one tracking file. When you open it, there will be no profiles, tags, or download pins. Track files use 
the GPX format, augmented with a couple of minor extensions. A track file is independent of any RSK, but Ruskin uses it 
to inject location data into the RSK whenever the RSK is downloaded. The RSK geodata table will contain one row for 
every GPS entry captured during the deployment.  

In most cases, you do not need to access the GPX file as RSK contains all the needed data. However, you have an option 
to upload the GPX files from the Ruskin app independently of RSKs. You may wish to use a track to illustrate your course 
on a map using various online tools, or convert it to other formats such as GeoJSON or KML. 

Profiles

Open the dropdown menu and tap on a dataset.

A map will open, showing the tracked route recorded during deployment. Tap on the Information drawer button at the 
top right to view the details related to deployment, waypoints, instrument, and map type. 

https://en.wikipedia.org/wiki/GPS_Exchange_Format
https://geojson.org/
https://en.wikipedia.org/wiki/Keyhole_Markup_Language
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There are three colours used to draw the track:
1. A red line for the downcast segments
2. A green line for the upcast segments
3. A light grey line for segments not associated with 

the profile (e.g. out-of-water periods

There are three types of tag pins used to mark locations:
 Red profiles tag pins with numbers
 Purple manual tag pins with a letter "T"
 Blue download tag pins with a letter "D"

Download tags are automatically added whenever the 
instrument downloads to your mobile device. Typically, it 
occurs when the instrument ascends and reaches the 
surface, or at the end of a deployment. They are hidden 
by default. Use the toggle switch on the information 
drawer to display them. You will see them appear 
whenever the line colour changes from green to red, and 
at the very end of the track. 

Tap on a tag pin to open an information window. For the 
red profile tag pins, it includes a link to view the chart for 
that profile.

If no raw tracks coincide with a deployment, only download and manual tag pins will be displayed. Download pins are 
hidden by default, so if there are no manual tag pins, the map may appear empty. 

In the absence of track data, Ruskin Mobile searches for any automatic waypoints from instrument downloads and will 
sometimes be able to position some profiles from these and thus display some profile pins.

If track data is not available for the full deployment, some profile pins may be missing from the map. Refer to the 
information drawer to see how many profile locations could be determined.
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6.6 Adjust your settings
When connected to an instrument, the Settings view allows you to manage your deployment preferences. 

Dropbox

Sign in to Dropbox to enable Dropbox integration. Click 
on Connect to Dropbox and follow the prompts.
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By default, the datasets will be automatically deleted 
from your device once they are uploaded to Dropbox. 
 Use the toggle switch to change this preference.  

Clock Sync

When you start a deployment, you can automatically set 
the instrument time from your phone or tablet.

As the instrument has a clock but no concept of time zones, you can select UTC or Local time, or you may choose to set 
no time at all by selecting Off.

When you remove batteries from your instrument for more than a few seconds, the clock will reset (back to the epoch).  
Starting a new deployment with the Clock sync option enabled provides a convenient way to correct the clock.

.

Units of measurement

By default, your charts will plot temperature in Celsius 
and depth in metres.

Change your viewing preferences to Fahrenheit for 
temperature and feet or fathoms by making your 
selections under Charting. 

.

By default, your maps will use kilometres per hour for 
velocity and kilometres for distance. 

Change your viewing preferences to metres per second 
or knots for velocity units and nautical miles for distance 
by making your selections under Location. 

Alternative units of measurement will allow you to view the charts in preferred format, but will not affect the 
units in which the data were originally captured in the datasets. 



RBR#0006105revQ 38

7 Connections
Use the Connections tab to view and manage devices connected to your computer via physical ports or Ethernet.

In the Navigator window, click Instruments.  The Connections tab will open on the right. The table will include ports, 
statuses, RF latency selections, and the device type for each connected device. .

Column Information

Port If your instrument is plugged in to your computer, this column will identify the physical port by 
name, such as "COM5" (if using Windows) or by its address, such as "/dev/
tty.usbmodem141101"  (if using MAC OS). 

Status The column will display a success message, such as "Connected to RBRconcerto³ 209681", or 
an error message, such as "Unable to connect to host".

RF latency (s) From the dropdown menu, select a value up to 29 seconds.  The selected value will extend the 
allowable time for an instrument to respond to a command. Use this option when on a long 
cable or slow Wi-Fi connections.

Device The column will display the device type for each connected device:

Logger: Instruments connected via USB, serial (RS-232), or TCP connections
 RS-485: Instruments connected via serial (RS-485) connections
 GPS: NMEA streaming devices
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As soon as you plug in an instrument, Ruskin will detect it and add it to the list. .

Click on one of the instruments to switch to its Configuration tab.  

If you unplug an instrument, the port will remain enabled as long as the port checkbox remains selected. Ruskin will 
automatically reconnect to the instrument when it is plugged back in. 

Deselect the checkbox next to your instrument to disable transport to its port. After this, Ruskin will not detect any 
instrument plugged into this port..

To restore transport, reselect the checkbox.  Your  instrument will re-appear in the  Navigator  window.
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8 Configuration
Use the Configuration tab to set up your deployment parameters. 

After setting up a desired schedule, verify that it meets your requirements. To return to previous settings, click Revert 
settings. 

To save the settings for the new schedule, click Enable.  New values will replace all previously stored schedule 
parameters. 

To apply the same schedule to multiple instruments with the same sampling capabilities, set up the first instrument 
and click Enable.  Connect all other instruments to Ruskin and click Use auto-deploy settings. Now all instruments will 
run on the same schedule, including logging times, power options, sampling parameters, and gating conditions. See 
Automatic tasks for details. To return to previous settings, click Revert settings.

8.1 Update firmware
Ruskin automatically checks if your instrument firmware is up-to-date. Updates may be critical, routine, or customised. 

If a newer version is available and this update is critical, the Update firmware button and a warning message will 
appear at the top of the Configuration tab. 

See Critical firmware updates for details. 

You cannot use Revert settings after clicking Enable.  To change a schedule already enabled, stop the 
instrument, restore old values manually, and click Enable again. 

Enabling a new schedule will remove all the existing data on the instrument. Make sure to download the data 
from the instrument before starting a new deployment.
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8.2 Schedule
The Schedule section includes four fields: Status, Clock, Start, and End. 

Status

The Status field displays the current state of your instrument.

Status Description

Not enabled A deployment has not been enabled.

Configuring instrument Ruskin is writing the deployment configuration to the instrument.

Schedule enabled A deployment has been enabled, but the start time has not yet been reached.

Paused A deployment has been enabled, but a gating condition has not been met.

Logging in progress A deployment has been enabled and the instrument is currently obtaining 
samples and recording them to memory.

Logging, memory full A deployment has been enabled and the instrument is currently obtaining 
samples, but they are not being recorded to memory as there is no available 
space. Data continues to be transmitted over the chosen realtime link.

Stopped, schedule complete A deployment has reached the end time and so has been stopped.

Stopped, memory full The memory has been completely filled with samples and so logging has been 
stopped.

Stopped, user request An enabled deployment has been stopped by user intervention.

Failed An internal error has occurred during a deployment.

Battery failed An internal error regarding the batteries has occurred.
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Clock

The instrument clock may drift up to 60s per year. Hover your mouse over the time value to display the offset. 

Synchronise the instrument clock before each deployment. Select UTC or Local  time, depending on your preferences. 

Start

Specify the Start date using the dropdown calendar, and the Start time using the up and down arrows. Alternatively, 
check Now to start logging as soon as the Enable button is clicked. 

End

The End date is calculated by Ruskin autonomy engine and indicates when your deployment is likely to stop. This is 
based on sampling schedule, mode, and power selections . Ruskin autonomy engine provides feedback on which 
parameter (power or memory) will be exhausted first. 

The parameter in the green bar is the true deployment estimate. In the example shown, your deployment will last 115 
days, until the battery is exhausted. 

The parameter in the orange bar indicates how much longer the deployment could last if the preceding parameter 
were not a factor. In the example shown, if your instrument were still powered after 115 days, it could continue logging 
for 496 days more, until the memory becomes full. 

The Start date and time are only editable If the Gating condition is set to None. Otherwise, it is the Gating
condition selection that will control the start of logging. See Gating for details. 

To manually edit the originally set date and time values, select and then clear the Now checkbox.

Deployment estimates on Ruskin assume new batteries. Your real deployment times may be shorter if the 
batteries are not fully charged.  

If the End logging date is power dependent and you know that the instrument will be operating under very 
cold conditions, you may want to lower the demands on the battery by lengthening your sampling period or 
opting for different battery chemistry.
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Ruskin autonomy engine

Ruskin autonomy engine relies on several parameters to estimate the deployment end date: sampling rate, power 
options, and memory. One of the key factors is battery life.  

Battery life prediction is a complicated issue. In RBR instruments, it is a strong function of the type of instrument, type 
and number of sensors attached, sampling mode (sampling rate, gating conditions, realtime data collection), and water 
temperature during the deployment. Manufacturer's data for the batteries may not reflect the way batteries are used in 
RBR instruments, and thus, are not always informative.

Autonomy figures depend on the power draw of the instrument, as well as the derated capacity of the battery pack. 
Batteries are derated to 4°C. These values differ for different battery chemistries. For the most accurate deployment 
estimates, select the same batteries from the dropdown menu as installed in your instrument. 

Ruskin calculates the expected battery usage for the instrument during setup . The nominal capacity of each type of 
battery is described  in the Power section and is given in mAh at room temperature. Battery voltage does not decrease 
linearly and is therefore not an accurate indicator of battery capacity.

RBR tested batteries of various brands at 6°C; all of them were able to provide the threshold capacity defined in the 
Power section. View these predictions and further de-rate the batteries if the expected deployment is in cold water. 

The software will warn you if the expected battery usage for a particular deployment scenario is approaching the 
theoretical potential mAh.

The software will not prevent your instrument from being started even if a warning is given. However, adjusting 
deployment parameters or replacing the batteries may help extend deployment times. 

8.3 Power
The Power section includes internal and external power options, as well as information on sampling power.  Ruskin 
autonomy engine uses these parameters to estimate deployment life. 
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Battery

The Battery dropdown menu shows available chemistry options for internal batteries. The list depends on your 
instrument. RBR ships all new instruments with batteries of the highest capacity for the instrument type already 
installed. 

AA-type batteries

Most RBR instruments use AA-type batteries, the only exception being the RBRquartz3 Q | plus, which uses D. 

Typically, RBR instruments are shipped with EVE ER14505 lithium thionyl chloride or Energizer L91AA lithium iron. 
Select your battery chemistry from the dropdown list.

Name Chemistry Voltage (V) mAh*

Lithium thionyl chloride Li-SOCl2 3.6 2700

Lithium iron Li-FeS2 1.5 3500

Alkaline Zn-MnO2 1.5 2500

Li-ion Li-NiMnCo 3.6 750

Nickel metal hydride Ni-MH 1.2 2400

*The nominal capacity of each type of battery is given at room temperature. 

D-type batteries

The RBRquartz3 Q | plus uses D-type batteries and is typically shipped with Tadiran TL-4930 lithium thionyl chloride. 
Select your battery chemistry from the dropdown list.

Mixing batteries of different chemistries, brands, and age will reduce performance and potentially damage the 
instrument. Improperly matched batteries may become overheated, leak, or even explode.

Lithium thionyl chloride batteries are only recommended for T, D, T.D, C.T, C.T.D, and RBRquartz3 instruments. 
Any additional sensors will not work correctly on this type of battery. 
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Name Chemistry Voltage (V) mAh*

Lithium thionyl chloride Li-SOCL 2 3.6 18400

Alkaline Zn-MnO2 1.5 16000

Nickel metal hydride Ni-MH 1.2 10000

*The nominal capacity of each type of battery is given at room temperature. 

Deployment estimates

Ruskin estimates autonomy figures based on the power draw of the instrument, as well as the derated capacity of the 
batteries. Batteries are derated to 4°C . These values differ for different chemistries (see above). For the most accurate 
deployment estimates, select the same batteries from the dropdown menu as installed in your instrument. 
Alternatively, use Ruskin to simulate your instrument with different batteries and find which chemistry works best for 
your deployment.

Select the Fresh checkbox when installing fresh batteries in your instrument for the next deployment. When checked, 
Ruskin autonomy engine will reset usage statistics and adjust deployment estimates accordingly.

External

The External dropdown menu shows external power supply options. These include RBRfermata and RBRfermette3

underwater battery canisters with various battery chemistries available. RBRfermata uses D-type batteries, and 
RBRfermette3 uses AA cells. See above for battery chemistries available. Ruskin autonomy engine will estimate 
deployment life based on your selections.

Select the Fresh checkbox when using a new battery canister or after replacing batteries in your RBRfermata and 
RBRfermette3 before the next deployment. When checked, Ruskin autonomy engine will reset usage statistics and 
adjust deployment estimates accordingly.

Select the Extended battery end-cap checkbox only if your instrument has a connectorised end-cap. In this case, 
Ruskin autonomy engine will account for the power supplied via the end-cap when estimating deployment 
life. Otherwise, leave the box unchecked. 

Battery cells of the same chemistry but from different manufacturers may have different performance.  If the 
nominal capacity of the battery model you are using is lower than outlined above, your actual deployment 
may be shorter than the estimate.

Replace batteries before each deployment to maximise the operational time and prevent data loss.
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Sample power details

Click on the arrow to open the information drawer with sample power details, such as energy per sample, sample 
duration (if applicable), and sleep power. 

8.4 Sampling
The  Sampling section includes three fields: Mode, Speed, and Rate, as well as several optional fields available with 
certain sampling modes. 

Mode

Depending on your instrument, different dropdown options may be available. See Average, Burst, Directional, Tide, 
and Wave for information on how to configure these modes. 

RBRconcerto3 C.T.D: RBRquartz3 Q: RBRquartz3 BPR | zero:

Speed and Rate

These are the only two parameters you need to configure Continuous sampling mode.

The RBRquartz3 BPR | zero can only operate in Continuous sampling mode.

https://docs-rbr.atlassian.net/wiki/spaces/RUSKIN/pages/17432684
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Check Speed to select the sampling Rate in Hz from the dropdown menu. The 
default option is always the highest instrument rating. For example, | fast16 will 
default to 16Hz.

Uncheck Speed to enter the sampling Rate manually in hours, minutes, and 
seconds (HH:mm:ss format). The fastest rate to enter manually is 1s. Type the 
numbers in, or use the up and down arrows.

8.4.1 Average
When set to Average, the instrument will collect data at a certain rate, and then average those samples to produce a 
single value to store on the instrument. This sampling mode allows you to save memory during long deployments. 

In addition to Speed and Rate, there are two more parameters required for Average mode: Duration and Interval. 

Duration specifies the time range over which to average. It must always be longer than Speed.

Interval is the repetition period for performing the averaging. It must always be longer than Duration.

There are two versions of sampling controls for Average sampling mode: simple and advanced. Make your selections in 
Preferences > General.

Simple sampling controls

When using the simple version, select Speed, Duration, and Interval from pre-
defined options in three dropdown menus.  

In the example shown, the sampling rate selected is 2Hz (two samples per 
second). The instrument will be logging for a duration of five seconds, then pause 
and average the ten samples collected. After an interval of five minutes, it will start 
logging again, repeating the same cycle. 

All profiling instruments (known as  | fast) can sample faster than 2Hz and support Average and Burst modes. 
All  | tide and  | wave instruments can average at rates of 2, 4, 8, or 16Hz.

https://docs-rbr.atlassian.net/wiki/spaces/RUSKIN/pages/17432684
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Advanced sampling controls

When using the advanced version, select two or all three parameters manually. 

In the example shown, the sampling rate selected is 2Hz (two samples per 
second). The instrument will be logging for a duration of one minute, then pause 
and average the 120 samples collected. After an interval of five minutes, it will 
start logging again, repeating the same cycle. 

In the second example, the sampling rate selected is 1s (1Hz, or one sample per 
second). Duration and Interval are the same in both examples. 

8.4.2 Burst
When set to Burst, the instrument will collect a specified number of samples at a specified rate, and repeat this 
operation at a specified interval.

In addition to Speed and Rate, there are two more parameters required for Burst mode: Duration and Interval. 

Duration specifies the number of samples to record.

Interval is the repetition period for performing the burst.  The countdown begins at the same moment the burst starts 
and, therefore, Interval must always be longer than the time it takes to obtain the number of samples indicated in 
Duration.

There are two versions of sampling controls for Burst sampling mode: simple and advanced. Make your selections in 
Preferences > General.

At every Interval, the instrument records only one sample, averaged over all samples collected during the 
period of Duration. The rest of the samples are discarded after averaging is performed. 

Only instruments with the | fast sampling feature (| fast8, | fast16, or | fast32) support Burst sampling mode.
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Simple sampling controls

When using the simple version, select Speed, Duration, and Interval from pre-
defined options in three dropdown menus.  

In the example shown, the sampling rate selected is 2Hz (two samples per 
second). The instrument will be logging for a duration of 512 samples (256 
seconds), then pause for 44 seconds (that is, until the countdown reaches 300s or 
five minutes). After an interval of five minutes, a new burst of 512 samples will 
occur, the instrument repeating the same cycle. 

Advanced sampling controls

When using the advanced version, select two or all three parameters manually. 

In the example shown, the sampling rate selected is 32Hz (32 samples per second). 
The instrument will be logging for a duration of 512 samples (16 seconds), then 
pause. After an interval of ten minutes (minus 16 seconds), a new burst of 512 
samples will occur, the instrument repeating the same cycle. 

In the second example, the sampling rate selected is 1s (1Hz, or one sample per 
second). Duration is 60 samples, and Interval is five min, which means the 
instrument will be logging for one minute until pausing for four. 

8.4.3 Directional
When set to Directional, the instrument will collect data at specified rates depending on the direction it is travelling. 
This sampling mode is intended for use when the instrument is integrated into a moving platform.

There are several parameters required to set up Directional mode: Threshold, Fast sampling direction, Fast sampling 
speed, and Slow sampling speed.

Only instruments with the |fast sampling feature (| fast8, | fast16, or | fast32) support Directional mode.
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Threshold is the distance from the previous minimum or maximum (in dbar) at which the instrument will switch to the 
opposite sampling speed. This value should be greater than zero. The minimum precision is 0.1dBar.

To optimise deployment life without compromising data in the preferred direction, it is recommended to set the 
Threshold value to 5-10% of expected profile distance.

Fast sampling direction indicates which direction the instrument should sample at the fast rate.
 Ascending indicates that the instrument should sample at the Fast sampling speed during ascents
 Descending indicates that the instrument should sample at the Fast sampling speed during descents

Fast sampling speed has the same meaning as Speed in Continuous mode, but applies only when the instrument 
detects that it is moving in the preferred direction.
This must be faster than the provided Slow sampling speed parameter.

Slow sampling speed has the same meaning as Speed in Continuous mode, but applies only when the instrument 
detects that it is not moving in the preferred direction.
This must be slower than the provided Fast sampling speed parameter.

Refer to the graph below for different scenarios of directional logging. In this example, the Fast sampling direction is 
set to Ascending.

First profile

The instrument must record one complete profile to obtain the first minimum and maximum, which will serve as initial 
points for the threshold. Due to this requirement, it will sample the entire first profile using the Fast sampling speed 
(black dots). Once this has been completed, it will perform the desired sampling functionality. 
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Downcast 1

The instrument passes over its first maximum and reaches the threshold value. At this point, it switches to slow 
sampling (red dots).

Slow sampling then continues until the threshold value (with respect to the first minimum) is detected. The instrument 
switches to slow sampling and soon begins to ascend. 

Downcast 2

The instrument passes over its second maximum and reaches the threshold value. It again switches to slow sampling 
(red dots). 

Slow sampling then continues until the threshold value (with respect to the second minimum) is detected.  The 
instrument switches to slow sampling, but this downcast turns out to be longer than the previous one and it descends 
much deeper before starting the next ascent. 

Downcast 3

The instrument passes over its second maximum and reaches the threshold value. It again switches to slow sampling 
(red dots). 

Slow sampling then continues, but this time, the previous minimum was deeper, and the instrument begins to ascend 
before reaching the threshold value and thus, still sampling at the slow speed.

However, the instrument detects an upcast from pressure readings when the pressure drop of 3dbar is recorded. At this 
point, it switches to the fast sampling mode.  

Downcast 4

The instrument passes over its third maximum and reaches the threshold value. It again switches to slow sampling (red 
dots). 

Slow sampling continues until the minimum threshold estimated from the detected upcast value is reached. 

8.4.4 Tide
Tide sampling mode is similar to Average, as the instrument will also collect data at a certain rate, and then average 
those samples to produce a single value to store on the instrument. However, when set to Tide, the instrument uses 
averaging to remove wave noise data from pressure measurements.

The first slow sample is recorded at the fast speed because it had already been scheduled by the time the 
instrument detected the threshold. The same will apply when the instrument switches back to the fast speed. 
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In addition to Speed and Rate, there are two more parameters required for Tide mode: Duration and Interval. 

Duration specifies the time range over which to average. It must always be longer than Speed .

Interval is the repetition period for performing the averaging. It must always be longer than Duration .

There are two versions of sampling controls for Tide sampling mode: simple and advanced.  Make your selections in 
Preferences > General.

Simple sampling controls

When using the simple version, select Speed, Duration, and Interval from pre-
defined options in three dropdown menus.  

In the example shown, the sampling rate selected is 16Hz (16 samples per second). 
The instrument will be logging for a duration of one second, then pause and 
average the sixteen samples collected. After an interval of five minutes, it will start 
logging again, repeating the same cycle. 

Advanced sampling controls

When using the advanced version, select two or all three parameters manually. 

All parameters are the same as in the previous example. 

8.4.5 Wave
Wave sampling mode is similar to Burst, as the instrument will also collect a specified number of samples at a specified 
rate, and repeat this operation at a specified interval. When in Wave mode, the instrument takes multiple pressure 
readings in a burst and reconstructs the surface wave time series. This mode records both tide and wave information. 

Both instruments with the | tide16 and | wave16 features support Tide sampling mode. 

At every Interval, the instrument records only one sample, averaged over all samples collected during the 
period of Duration. The rest of the samples are discarded after averaging is performed. 

Only instruments with the | wave16 feature support Wave sampling mode. 
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Speed or Rate are parameters defining individual pressure readings. 
 The highest possible frequency visible in the data is limited to ½ the sampling rate. However, this mathematical 

limit cannot be achieved because of wave attenuation, and real data are actually lower. 
 The sampling rate defines the resolution of the frequency spectrum which can be calculated from the wave 

data. 
 The sampling rate, together with the burst duration, defines the lowest frequency which can be assessed in a 

wave burst.

In addition to Speed and Rate, there are two more parameters required for Wave mode: Duration and Interval. 

Duration specifies the number of samples to record.

Interval is the repetition period for performing the burst. It must always be longer than the time it takes to obtain 
the number of samples indicated in Duration.

Furthermore, you may enter Instrument altitude and Mean depth of water to estimate possible wave periods for your 
deployment. These parameters are not mandatory for the instrument to work, but allow you to get an idea of what to 
expect. 

 Instrument altitude is the actual height of the instrument in metres above the seabed. This is defined by 
deployment requirements, and the instrument must be physically affixed at this height during the installation.

 This parameter is stored on the instrument and used to compute wave statistics for pre-deployment 
analysis.

 Mean depth of water is an estimate of the average water depth in metres, used for the initial prediction of wave 
frequency. It must always be greater than Instrument altitude. 

 This parameter is not stored in the logger and only used to compute wave statistics. It is adjusted post-
deployment through the RSK file.

 Ruskin will calculate the actual mean depth of water from the instrument altitude and its depth 
measured during the deployment. 

There are two versions of sampling controls for Wave sampling mode: simple and advanced. Make your selections in 
Preferences > General.

Simple sampling controls

When using the simple version, select Speed, Duration, and Interval from pre-defined options in three dropdown 
menus.

A common configuration is 4Hz sampling for 4096 samples every 30 minutes.  

Consider unique aspects of deployment environment when setting up Wave sampling mode.
For example, while a 30-minute interval tends to work in most cases, shorter intervals may suit better when 
encountering ocean swells which have longer wavelengths than noise but shorter than tide. 
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Enter Instrument altitude and Mean depth of water
manually. Estimates for wave statistics will be 
immediately displayed: maximum wave frequency and 
minimum wave period (essentially, they reflect the same 
concept because period = 1/frequency). These values can 
be adjusted post-deployment through the RSK file.

Advanced sampling controls

When using the advanced version, enter all or some 
parameters manually.

This option allows more flexibility with your values. For 
example, with a rate of 4Hz and a duration of 4096 
samples, the instrument will be sampling 17 minutes 4 
seconds. You can set up near continuous sampling by 
setting the interval to 17:05. Logging will be on every 
second except the one remaining second of the interval, 
and then start again. 

Deployment depth of | wave16 instruments

Attach your  | wave16 instrument to a suitable support below the surface of the water, such as a dock or other rigid 
mooring, to completely immobilise it.  

Enter the expected mean depth of water and the known instrument altitude (height above the seabed). From these 
values, Ruskin will estimate wave frequencies and wave periods that your instrument could measure (period = 1/
frequency). On data retrieval, Ruskin will calculate the actual mean depth of water from the instrument altitude entered 
and its depth measured using the pressure transducer, and then use this actual depth for computing all wave statistics 
during deployment. 

The physics of what a pressure transducer can measure depends on the height of water above as well as the depth of 
water below it. High frequencies attenuate very quickly with depth. The depth of the deployment is critical in 
determining frequencies/periods of the wave data the instrument will be able to capture. It is the depth, not orientation 
of the pressure transducer that affects these measurements.

The timestamp of the burst for both Tide and Wave datasets is the beginning of the burst.

The basic rule is to place the instrument as close to the surface as possible without it emerging from the water 
due to large waves or low tides.
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 Instrument fixed to a dock below the water surface  Wave attenuation as a function of depth for various wave 
periods

8.5 Gating

The Gating section allows you to enable your 
deployment using a method other than time-based. 
From the dropdown menu, select Twist activation to 
start your deployment by twisting the end-cap or Marine 
wet switch to enable the instrument based on contact 
with water.  Otherwise, set it to None to use the specific 
Start time from the Schedule section. 

Twist activation 

When you select Twist activation, the instrument starts to sample based on the twist on/off position of its end-cap 
rather than a schedule.

To start sampling, first click Enable. This button is at the 
bottom of the Configuration tab. 

The Marine wet switch option is only available for instruments with a conductivity sensor. 
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The button will then become a Stop button. The status 
will become "Logging paused".

Turn the battery end-cap to the RUN position. The instrument will vibrate with one 
long pulse and start sampling.

To pause it, turn the battery end-cap to the PAUSE position. The instrument will 
vibrate with three short pulses to indicate it has stopped logging. 

Twisting the end-cap to the RUN or PAUSE position will activate the Wi-Fi. However, twisting to PAUSE will 
also pause the instrument. Twisting to RUN will resume sampling.
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Marine wet switch

When you select Marine wet switch, the instrument starts to sample as soon as it enters the water. This method is 
based on the conductivity sensor measurement.

To start sampling, first click Enable. The status will become "Logging paused". After that, the instrument will be 
checking the value on the conductivity sensor every 15 seconds. If it exceeds 1mS/cm2, the instrument will start logging 
and continue so until the conductivity values decrease below this threshold. Ruskin always updates with the correct 
state. 

8.6 Options
The Options section offers additional settings for deploying your instrument. 

Realtime

Specify your external streaming connection. Select one of the three options:
 None to disable streaming to any external connection
 Serial to fetch or stream your data over an external underwater connection (RS-232 or RS-485).
 USB to fetch or stream your data over an external USB connection

If you select None, you disable streaming and enable fetching, provided you are still connected to the instrument via 
your internal USB port. Click the Fetch button in the Plot view toolbar. The samples fetched from the instrument will be 
displayed on a live plot at the default speed of about one second. This collection rate is independent of the sampling 
speed configured in the instrument.

If you set Realtime to Serial, proceed to the Mode dropdown menu (see below) and select RS-232 or RS-485.

If you are interfacing to an external system that requires a control signal input, such as a modem with a DTR input, 
configure the parameters for the auxiliary output control signal from the instrument.

Serial

Select the baudrate of the external serial connection. Factory baudrate is 9600. 

Storage

Select your deployment mode, which will determine the RSK file format. By default, new deployments started from a 
laptop or desktop computer are set to the Desktop storage format. However, if you enable Wi-Fi on your instrument or 
start your deployment from your mobile device, this option defaults to the Mobile storage format.

Format

Select the output format for the realtime data from five dropdown options. 

The threshold value for Marine wet switch may not be suitable for freshwater applications as many 
freshwater sources would not exceed 1mS/cm2
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 Standard resolution
All values are shown to four decimal places, with no units displayed.

 Standard resolution (units)
All values are shown to four decimal places, with units displayed (after the number, separated by a space).

 Highest resolution (RBRquartz)
All values are shown with enough significant digits ensuring no loss of resolution.

 Engineering
All values are shown in engineering notation (same as scientific notation, but the exponent must be a multiple of 
three), with enough significant digits ensuring no loss of resolution.

 Standard resolution (checksum)
All values are shown to four decimal places, with no units displayed. The output has the leading characters 
"RBR" and the serial number of the instrument, and a checksum (CRC) at the end, which can be used to validate 
that the transmission was successful.

Mode

Select from available external serial connections communication protocols: RS-232, RS-485 FD, UART - (OEM), and
UART Idle low (OEM).

Wi-Fi

Select "on" to allow your instrument to use the Wi-Fi module.

8.7 Voltage sensors
The Voltage sensors section includes three fields: Channel, Latency, and Current. Ruskin uses these parameters to 
estimate deployment time (battery use) and to determine minimal sampling intervals. 

The Channel field displays the sensor index on the instrument, for example, 4. If there is more than one voltage sensor, 
select them from the dropdown list. 

Use up and down arrows to change Latency. It specifies the wait time it takes the sensor to settle after powering up 
before it can take a reading. The units of measurement are milliseconds. Use up and down arrows to change this 
parameter. 

Enter the Current value manually in the field provided. This is the sampling current required for the sensor to operate 
at a voltage of 12V. The units of measurement are milliamperes. 

UART - (OEM), and UART Idle low (OEM) are for OEM customers only. Contact RBR if you have any questions. 

This selection will not turn the Wi-Fi on or off.  It is the instrument that controls the state of Wi-Fi. 

You must enter these parameters for sensors not supplied by RBR.

mailto:support@rbr-global.com


RBR#0006105revQ 59

8.8 Ranging sensors
The Ranging sensors section has two dropdown menus, Sensor and Range. 

Sensor displays the name and index of the channel, possible ranging sensors may be turbidity and fluorescence 
(chlorophyll or chlorophyll a, cDOM, backscatter).

Range specifies the gain level used for the deployment. This parameter can be set to an auto-ranging setting or to a 
fixed gain setting. The fixed gain setting is specified by selecting one of the ranges specified. The units of measurement 
are NTU (Nephelometric Turbidity Units) for turbidity sensors, μg/l for chlorophyll, and counts for cDOM and 
backscatter. 

Set Range to Auto to enable the auto-ranging setting. Your instrument will change the gain setting on the front-end 
amplifiers to the range most appropriate for its environment.  To display the range change events, select Diagnostic
from the dropdown under the Events button (blue triangle) in the Plot window toolbar.

Range change events are displayed as "RANGE XX Units" where XX indicates the current range and units are the units of 
measurement, for example: RANGE 500 NTU. For  | fast sampling, where the change may be occurring over a number of 
samples, the label will read, "RANGE CHG", followed by the final range change event.

Alternatively, select a fixed gain setting to maintain the same setting throughout your deployment. 

8.9 Valve control
The Valve control section supports the RBRquartz3 BPR | zero, which is the only RBR instrument with a switching valve. 
Properly setting the valve parameters improves deployment times. 

The Status field displays the current valve position: marine or atmospheric. Toggle manually between these option 
using the Set position radio buttons. 

Select the Schedule movement checkbox to set the move to the atmospheric position for the deployment. Toggle the 
movement Type between Uniform and Segmented. 
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Uniform movement will activate controls for:
 Duration, the time to spend in the atmospheric position
 Interval the time between valve movements to the atmospheric position 
 Skip first atmospheric duration option

Segmented movement will activate controls for:
 Segment, with entry fields for Selection and Count 
 Delay, the time to hold off before moving to the atmospheric position, 

measured from the start of the previous segment
 Duration, the time to spend in the atmospheric position
 Interval, the time between valve movements to the atmospheric position 

8.10 UV antifouling

The RBRduo3 C.T | uv  and RBRconcerto3 C.T.D | uv  use ultraviolet radiation to reduce biofouling of the conductivity cell 
and thus improve accuracy of measurements.  Four UV LEDs installed on the inside of the guard illuminate critical 
sensor surfaces at set intervals, slowing down the growth.

Power level
The Power level of UV LEDs  has three user-controlled settings: Off, Low, and 
Standard (recommended). Any option other than Off will activate the UV LEDs 
during the deployment.

An external power source, such as RBRfermata or RBRfermette3, is required for valve operation

An external power source, such as RBRfermata or RBRfermette3, is required for UV operation.

The UV LEDs will activate immediately after you enable the deployment. See RBR Instrument Guide: CT uv and 
CTD uv Instruments for safety precautions.

https://rbr-global.com/support/documentation/
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When the UV LEDs are active, Ruskin will display a warning and the red dots on the 
UV power icon will turn green. 

The UV interval and the duty cycle are factory-set to 60s and 25% (15s) 
respectively. 

Sampling

Sampling options for the | uv instruments depend on the UV schedule.
1. At the Standard power level, only 60s continuous sampling is available, 

and all selections are greyed out. 

2. At the Low power level, you can use the radio buttons to select either 30s 
continuous or 60s continuous sampling.

3. When the UV schedule is disabled (the Power level is set to Off), the 
standard instrument sampling controls are available.

Illumination cycle

When the UV schedule is active, Ruskin sets the first measurement for the first second of the illumination cycle, to 
minimise the noise from the UV pulse.  Other stages of the one-minute cycle depend on the Sampling settings. 

1. The 60s continuous.
The instrument performs a measurement for 1s, then the UV LEDs become 
active for 15s and turn off. The instrument waits for 44s until the next one-
minute cycle begins. 

2. The 30s continuous.
The instrument performs a measurement for 1s, then the UV LEDs become 
active for 15s and turn off. The instrument waits for 14s after that and 
captures another sample (1s), and then waits for the remaining 29s until 
the next one-minute cycle begins.
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8.11 Download
The Download... button is located next to the Memory used bar, at the bottom of the Configuration tab.  

You can download data from your instrument at any time. However, it is especially important to do so when you stop a 
schedule. All the data on the instrument will be erased as soon as you enable a new deployment.

Steps

1. Click the Download... button. 
A dialog box will appear.

2. Enter a name for the data file in the Save As field, 
or accept the default name. 
By default, the RSK file name uses the Ruskin file 
naming convention (see RSK files). 

3. Select the download location from the Where
dropdown menu, or accept the default location. 

4. The new dataset will appear automatically in 
Navigator window under Datasets. 

RBR recommends storing your data on a local 
drive rather than a network storage drive. Cloud 
storage options such as GoogleDrive and 
Dropbox may extend download times.
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The Properties view will change to the new dataset, with 
the following tabs: Analysis, Overview, Channels, and
File info.

All the data stored on the instrument at the time of the 
download will be automatically plotted in the Plot
window.

5. When you download data again while on the same 
schedule, the RSK file will pick the same data and 
append it with any new data stored since the last 
download.



RBR#0006105revQ 64

6. Go to the Overview tab to add a comment for the 
download. Enter your message and click Save 
comment. 

8.12 Use auto-deploy settings
When working with a large number of similar instruments, Ruskin offers various automatic tasks, which can be set up 
from the Instruments menu on the top toolbar.

This feature may be convenient when you need to deploy several instruments with the same sampling capabilities. 
Select an instrument to use as the model and configure it. This will be your model schedule. Verify that these settings 
meet your requirements and all values are entered correctly. 

When you connect to an instrument with same sampling capabilities as the model instrument, Ruskin will configure it 
to match the model schedule. 

If you were connected to an instrument before setting up your model schedule, you can click Use auto-deploy settings
to apply them to that previously connected instrument. 

Click Revert settings when you wish to return to a previously configured schedule. 

Enable each instrument individually to start deployments. 

To confirm which auto-deploy parameters are set on Ruskin, go to Instruments > View auto-deploy 
settings... . The Auto-deploy settings box will open, with saved parameters outlined. 

You cannot use Revert settings after clicking Enable.  To change a schedule already enabled, stop the 
instrument, restore old values manually, and click Enable again. 
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8.13 Enable / Stop
Ensure that your instrument is ready to be deployed before enabling a schedule. See Deploy your instrument. 

To allow the instrument to start logging, click Enable. This button is at the bottom left of the Configuration tab.  

The Enable button will now read Stop. The status will 
become "Logging paused", "Schedule enabled", or 
"Logging", depending on the configuration. 

Logging will start when one of the following occurs:
 The Now button is checked
 The Start time arrives
 The Gating condition for starting is met

If you  click Enable, and the instrument memory is not empty, you will see a warning.

Before proceeding, download the data from your instrument (see Download). If you are sure that the information is 
saved or not needed, click Erase and enable logging.

To manually stop the instrument, click Stop.

Logging will stop on its own when one of the following occurs:
 The End logging time is reached
 The Gating condition for stopping is met
 The power source is removed or depleted
 The memory is filled

All editable fields become greyed out after you enable a schedule. 
To change any deployment parameters, stop your instrument, adjust the settings, and start a new 
deployment.
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9 Information
Use the Information tab to view general information for each of your instruments, such as model, generation, serial 
number, firmware version, power source, and the channels. 

In the Instrument details section, find the model, generation, and serial number for your instrument, as well as the 
firmware version installed and link used. 

Refer to the Power section for the power source, power type (internal or external), and voltage. 

The voltage value indicated for the internal source indicates the power remaining in your batteries. 

Please note that the power drop in lithium batteries is very sharp, so it may not be a good idea to rely on this indicator 
 to predict battery life. However, it is quite reliable for alkaline batteries. 

Under Channels, confirm measured and derived parameters for your instrument. 

If you see a warning sign on the Calibration tab, certificates for one or more sensors are out of date.

Click Download to obtain the PDFs of the most recent calibration certificates for each channel. This only works if you 
are online.
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10 Calibration
The Calibration tab displays calibration coefficients for each parameter, and the date and time of the last calibration.

Select a sensor from the Parameter dropdown menu to 
display its calibrations.

RBR calibration certificates contain calibration equations, coefficients, and residuals for each sensor.

The date of the latest calibration is always displayed. As 
an extra reminder, you can select the Check calibration 
expiry checkmark. A warning sign will appear when your 
calibration certificate is out of date. 

RBR recommends calibrating your instrument before any critical deployment, periodically once a year, or if you suspect 
the readings to be out of specifications. 

Discuss your calibration requirements with RBR. In some 
cases, the instrument may need to be returned to RBR to 
have it checked and recalibrated.

To contact RBR for our current calibration fees, click 
Request calibration quote. A Request for quote dialog 
box will appear. 

Verify that all information is correct and click Submit.

mailto:support@rbr-global.com
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Simple calibration controls

When using the simple version, you will be able to view 
and edit only the main calibration coefficients, displayed 
as "C" values: C0, C1, C2, C3. 

Advanced calibration controls

When advanced calibration controls are enabled in 
Preferences > General, you will be able to view and edit 
both main and dependent coefficients. Dependent 
coefficients are displayed as "X" values: X0, X1, X2, etc. 

You can edit the coefficients. As soon as you make a 
change and move to another cell, a new calibration date 
will be displayed. Also, Store calibration and Revert 
calibration buttons will become active. 

Use Store calibration to save the new values.

Use Revert calibration to recover to the original coefficients if you have not already saved your changes to the 
instrument. 

Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost 
once your session is closed. 

You cannot use Revert calibration after clicking Store calibration. Once the coefficients are saved to the 
instrument, you will need to restore old values manually and save them again. 
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11 Parameters
The Parameters tab displays all the parameters the RBR instrument may need for calculating derived channels.

If your instrument can measure a parameter, it will use the measured value. Otherwise, you can enter the necessary 
values manually, and they will take effect immediately. 

For example, you always need atmospheric pressure and water density for derivation of depth. Default values in Ruskin 
correspond to sea level and sea water. Therefore, it is especially important to adjust these parameters when working at 
high altitudes in fresh water.

Enter atmospheric pressure (in dbar) and water density (in g/cm3) manually in the table under the Parameter tab. If not 
entered, default values of 10.1325dbar and 1.0281g/cm3 will be used. 
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12 Preferences
On your Mac, access Preferences from the Ruskin dropdown menu in the top toolbar.

On your Windows PC, use the Options dropdown menu to set up your preferences. 

Factory-set global defaults require no changes in most situations. However, as you learn more about what Ruskin can 
do, you may want to change some of these settings to better suit your requirements. The global preferences include:

 Derived channels (applies to some legacy instruments)
 Facility (authorised users only, requires login)
 General (download locations and options, sampling and calibration controls, export options)
 Plotting (channel visibility and channel colours)

12.1 Derived channels

The Derived Channels section of the Preferences dialog box has four tabs:  Depth, Conductivity - Salinity, Dissolved 
O2, and No sensor values, where you can choose additional channels derived from measured channels. 

Derived channels calculated by the instrument as well as those calculated by Ruskin are automatically added to the 
default channel list in both the live Plot view and the static dataset.

The Derived channels settings are intended for XR(X),1060, 2050, and 1050 RBR legacy data loggers. They do 
not apply to newer generations. They do not apply to any RBRcoda or RBRcoda3 instruments.
Newer generations calculate all possible derived channels for that specific instrument.
Use the Parameters tab in the instrument Properties window to set up initial parameters for calculating 
derived channels.
For downloaded files, use the Parameters tab in the dataset Properties window.
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Depth

If your instrument has a pressure channel, you can use its measurements to derive a depth channel. The data calculated 
for this derived channel appear along with measured channels in the Plot view and in datasets.

1. Select the Enable Depth Channel checkbox.

2. In the Atmospheric Pressure box, type the value in dbar or use the default value. This value corrects the 
pressure measurements during the depth calculation.

3. Select either the Simplified calculation or Seawater calculation.

4. 
a. To use the simplified calculation, type the actual water density, or use the default value. Note that for 

freshwater, the density should be set to 1.0.
b. To use the UNESCO seawater calculation, specify the latitude of the data collection in degrees and 

minutes.

For newer generation instruments, all derived channels are calculated regardless of the checkbox 
status.

The default Atmospheric Pressure value is 10.1325. Adjust this value manually to represent a different 
altitude.

Ruskin can calculate depth based on the simplified calculation or the UNESCO seawater calculation. 
The instrument always calculates depth using the simplified calculation.



RBR#0006105revQ 72

Conductivity - Salinity

If your instrument has a conductivity channel, you can use its measurements to derive salinity, density anomaly, 
specific conductivity, and speed of sound. 

1. Select the Use conductivity correction for derivation checkbox.

2. In the Hydrostatic pressure box, type the value in dbar or use the default value. 
3. Select derived channels to include in your calculations.
4. For the speed of sound, select between UNESCO, Del Grosso, and Wilson equations. 

.

For newer generation instruments, all derived channels are calculated regardless of the checkbox 
status.
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Dissolved O2

You can derive a dissolved oxygen channel that measures oxygen saturation as a percentage. 

1. Click the Dissolved O2 tab and select the Enable Dissolved Oxygen Channel checkbox.

2. If your instruments use the Oxyguard DO or RINKO DO sensor, select the Derive concentration using the Weiss 
equation checkbox and the output unit: µMol/L, mg/L, or mL/L.

3. If your instruments use the Aanderaa Optode DO sensor to measure oxygen saturation, select the Derive 
concentration using the Weiss equation checkbox and the output unit: mg/L or mL/L.

4. If any of your instruments use the Aanderaa Optode DO sensor to measure oxygen concentration, select the 
Calculate saturation using the Garcia and Gordon equation checkbox.

For newer generation instruments, all derived channels are calculated regardless of the checkbox 
status.

The Weiss equation requires values for temperature and salinity. If your instrument does not measure 
them, you can specify standard values on the No sensor values tab.

The Garcia and Gordon equation requires values for temperature and salinity. If your instrument does 
not measure them, you can specify standard values on the No sensor values tab.
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No sensor values

Enter salinity, pressure, and temperature values used to calculate the derived channels when a sensor is not available.

If you suspect that the derived channel value is incorrect, check to make sure that the No sensor values
entries match the deployment environment.
For example, if a dissolved oxygen saturation measurement is made in a lake at 8ºC but the No sensor values
salinity is 35 and the temperature is 15ºC, concentration reported will be incorrect.
Adjust the No sensor values entries and recompute.
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12.2 General
Use the General preference page to set up file locations, language, download options, sampling and calibration 
controls, and export options. 

File location

You can control where RSK files, realtime RSK file, and log files are stored by default. 

Specify these locations before downloading any data by typing in a directory name or by browsing. 

RSK files are the datasets obtained from your instrument. 

Realtime RSK files are generated when a connected instrument is streaming or when you enable fetching mode on the 
instrument.

You can click Apply to save your changes without closing the dialogue box.
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Log files are generated by Ruskin and help when diagnosing issues. These files are automatically attached to issues 
generated using the Comment on Ruskin feature.

You can change where future files are stored by default at any time. When done, click Apply or Apply and close.  The 
changes will take effect immediately.

Language selection

Ruskin is available in six languages: English, French, Spanish, Simplified Chinese, Korean, and Japanese.

Select your language from the dropdown menu and click Apply or Apply and close. Ruskin will need to restart for the 
changes to take effect. 

Download options

Select the appropriate checkboxes to change your download preferences.

When done, click Apply or Apply and close.  The changes will take effect immediately.

Sampling control

 Select the checkbox to enable advanced controls when setting up your sampling options.

With simple controls, you will select Speed, Duration, and Interval from pre-defined options in three dropdown 
menus.  When advanced controls are enabled, you will be able to enter these parameters manually and achieve a more 
precise setting. 

When done, click Apply or Apply and close.  The changes will take effect immediately.

Calibration control

 Select the checkbox to enable advanced controls when setting up your calibration options. 

With simple controls, you will be able to view and edit only the main coefficients (C). When advanced controls are 
enabled, you will be able to view and edit all main and dependent calibration coefficients (C, X) for any channel.

When done, click Apply or Apply and close.  The changes will take effect immediately.

Export options

Select the checkbox to enable raw data export. Use this option for downloading your RSK file when storage space is 
limited or expensive. The dataset will be exported in the most compact raw binary format. 

When done, click Apply or Apply and close.  The changes will take effect immediately.

12.3 Plotting
Adjust default settings for the graphical display in the Plot view. Manage selections in Channel visibility and Channel 
colours, and apply them globally.

RBR recommends storing your datasets on a local drive rather than a network storage drive. Cloud storage 
options such as GoogleDrive and Dropbox may extend download times.

The Enable download schedule UI checkbox is only for legacy instruments.

You can click Apply to save your changes without closing the dialogue box.



RBR#0006105revQ 77

Channel visibility

The Channel visibility tab displays many options to hide 
or show specific information.

Opt for displaying errors and events for a more 
informative graph, or hide them for a cleaner view. 

Select the By default, hide all measured channels
checkbox to display only derived channels.

Select the By default, hide all derived channels
checkbox to display only measured channels.

Otherwise, pick and choose channels to display or hide. 

When done, click Apply or Apply and close.  The changes 
will take effect immediately.

Channel colours

The Channel colours tab allows you to choose a different colour for each channel that is shown for information 
currently running in Plot view, or from an opened dataset. Select from the list of pre-defined options or create your own 
colour.

When done, click Apply or Apply and close.  The changes will take effect immediately.

You can override visibility preferences in the Plot view for any particular graphical display.
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13 RSK files
The RSK file is a single file database based on SQLite that allows us to have large files with high-speed access to any part 
of the dataset. RSK files have different types and versions, which reflect historical changes to the underlying dataset 
structure. To upgrade the version of an older RSK file, go to File info tab. 

RBR provides open-source RSKtools toolboxes for both Matlab (RSKtools) and Python (pyRSKtools) to read, post-
process, visualise, and export RSK files.

RSK files can be exported to Excel, OceanDataView®, or text files.

RSK files contain raw measurement data, firmware and software versions, dates and times, sampling settings, power 
settings, measured and derived parameters, errors and events, other diagnostic information. 

 Datasets in the Desktop storage format allow changes to calibration coefficients. GPS mapping for full RSK 
files relies on manually added location points.
This file format is available for RBR standard and compact instruments. 

 Datasets in the Mobile storage format support charting and GPS tracking. They do not allow changes to 
calibration coefficients.
This file format is only available for RBR standard instruments. 

 For datasets obtained via streaming or fetching, the RSK format is Realtime. Their names contain the "realtime" 
label. 
This file format is available for RBR standard instruments and RBR realtime sensors when in streaming mode, 
and for all instruments when fetching. 

To identify the type of the RSK file, go to the File info tab.  

Additionally,  you can identify a mobile RSK file by the absence of the Calibration option in the Analysis tab. 

File naming convention for datasets obtained during deployments

By default, RSK file names are composed of the following information:
 The instrument serial number: six digits
 The date of the download (YYYY-MM-DD): eight digits
 The time of the download (HH-MM in the 24-hour format): four digits

For example, the file named 209681_20220531_1306.rsk contains the dataset for an instrument with a serial number of 
209681; the data was downloaded on May 31, 2022 at 13:06 (01:06pm), local time. 

The RSK files obtained during a deployment are saved on your  instrument. Download them to your computer before 
starting a new deployment. Go to Preferences > General to change your default location for RSK downloads.  

File naming convention for realtime datasets

By default, realtime dataset names are composed of the following information:
 The instrument serial number: six digits
 The date of the download (YYYY-MM-DD): eight digits
 The time of the download (HH-MM in the 24-hour format): four digits
 The "realtime" label, indicating the data were streamed or fetched from the instrument

For example, the file named 209682_20220531_1408_realtime.rsk contains the dataset for a streaming instrument with 
a serial number of 209682; the data were saved on May 31, 2022 at 14:08 (02:08pm), local time.

The data streamed or fetched from your instrument are automatically saved to your computer. Go to Preferences > 
General to change your default location for realtime RSK files.  

The file extension is .rsk; it indicates the Ruskin file format and must not be edited. If you change it, your new 
file extension will become part of the dataset name, and the .rsk extension will be appended.

http://rbr-global.com/support/matlab-tools
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14 Realtime data format
Realtime data can either be streamed or fetched from the instrument. The output can be in a limited number of formats 
as described below. Each format is listed alongside an example output for an RBRconcerto3 C.T.D: 

Output format option Instrument setting Example data

Standard resolution caltext01 2018-12-10 13:06:38.000, 0.0005, 

22.9536, 10.1149

Standard resolution (units) caltext02 2018-12-10 13:06:38.000, 0.0005 mS/

cm, 22.9536 C, 10.1149 dbar

Highest resolution 
(RBRquartz)

caltext03 2018-12-10 13:06:38.000, 

0.000525642944, 22.939636, 

10.1149120

Engineering caltext04 2018-12-10 13:06:38.000, 

525.642944e-006, 22.9396360e+000, 

10.1149120e+000

Standard resolution 
(checksum)

caltext07 RBR 209681, 2018-12-10 

13:06:38.000, 0.0005, 22.9536, 

10.1149, 0x59CB

              

The output format can be changed in Ruskin from the instrument's Configuration tab. There is a drop down menu item 
called Format in the Options section.

 Standard resolution
All values are shown to four decimal places, with no units displayed.

 Standard resolution (units)
All values are shown to four decimal places, with units displayed (after the number, separated by a space).

 Highest resolution (RBRquartz)
All values are shown with enough significant digits ensuring no loss of resolution.

 Engineering
All values are shown in engineering notation (same as scientific notation, but the exponent must be a multiple of 
three), with enough significant digits ensuring no loss of resolution.

 Standard resolution (checksum)
All values are shown to four decimal places, with no units displayed. The output has the leading characters 
"RBR" and the serial number of the instrument. After the last data point, there is another field separator 
(command and space), followed by a checksum: two-byte CRC value which can be used to validate that the 
transmission was successful.

The values following the timestamp are all the enabled channels. 
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15 Datasets
Datasets are RSK files generated by Ruskin and have an .rsk extension. After downloading your datasets, you can view 
and analyse your data using the options below. 

Go to the File dropdown menu to open or close a 
dataset, export your data, and see the list of available 
datasets. 

The Datasets context menu in the Navigator windows 
duplicates some of these options for convenience.

Explore the contents of your datasets in the Properties
window.

When a dataset on the list is selected, 
the Properties window displays four tabs with 
information related to this dataset.

Use these tabs to analyse your data, check the 
calibration certificates, and verify your parameters. 

15.1 Open dataset
Open any stored dataset from the File menu in the top toolbar or from the Datasets menu in the Navigator view. 
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Steps

1. Click File > Open dataset.

Alternatively, right-click Datasets in the 
Navigator view and select Open dataset. 

2. A browsing window will appear. Double-click 
the .rsk file you want to view, or select the file and 
click Open. 

3. The name of the dataset appears and is 
highlighted automatically in the Navigator view. 
The Properties view changes to the dataset, with 
four tabs: Analysis, Overview, Channels, and File 
info.
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4. The data in the file will automatically appear in 
the Plot view.

15.2 Export
Use the Export option to share your data with others or analyse your data using other software. Datasets can be read 
directly in Matlab with our toolkit RSKtools, or exported to Excel, OceanDataView®, or text files. 

Steps

1. File menu > Export, 
then hover to open a set 
of submenus.
or right-click the 
dataset in the Navigator
window, then hover to 
open a set of submenus.

2. Select the appropriate export format (Microsoft Excel, netCDF/netCDF profiles, Text, OceanDataView 
spreadsheet, or Raw binary). 

To close a dataset, go to File > Close dataset. Alternatively, right-click the dataset name in the Navigator view 
and select Close dataset. 
 Alternatively, simply close its Plot tab by clicking the X. The dataset will disappear from the list.

For mobile or realtime RSK files, the Raw binary export format is not available.

http://rbr-global.com/support/matlab-tools
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3. If exporting annotations, select the category: Full profiles, Downcasts, or Upcasts.
4. Specify a location and a name for the data file. 
5. Click Save.

15.3 Analysis
Select a dataset in the Navigator view. The Properties view will change to dataset properties, with four tabs: Analysis, 
Overview, Channels, and File Info.

For datasets in the Mobile storage format, the Analysis
tab will only have the Cursor option.

For datasets in the Desktop storage format, it will also 
include Calibration.
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The Cursor view contains statistical information about 
deployment, as well as information about the dataset 
channels and their values. 

The colour-coding of the channel table matches that of 
the traces in the Plot window. To change the colour 
settings for your chart, go to Preferences > Plotting > 
Channel colours.  

Move the black cursor ("double lollipop") in the Plot
window to display parameter values for each sample 
selected.

Every time you move the black cursor, going from sample 
to sample, the table above the plot will display the 
information for this particular sample.

Select Display statistics checkbox to determine the 
average value and standard deviation over a range of 
samples. Change the number of samples to average 
using the up and down arrows.

The table will display the averaging data. The averaging 
interval will be highlighted in the plot.

When the Calibration view is available, you can recalculate your coefficients for some channels. See User calibration.
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15.4 Overview
Use the Overview tab to view general information for each dataset, such as instrument details and deployment events. 

To make a note about this dataset, enter your comment in the field provided and click Save comment.

15.5 Channels
For datasets in Desktop storage format, the Channels tab will have three options:  Information, Calibration, 
and Parameters. 

For datasets in Mobile storage format, the Channels tab will have only two options: Information and Parameters.
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Information

The Information page displays two tables: Measured channels and Derived channels.

Measured channels include measured parameters with their units of measurement, the sensor manufacturer, and the 
range setting (if applicable). 

Derived channels include all available derived parameters with their units of measurement and the methodology used 
to calculate them.

Calibration

The Calibration page displays the calibration coefficients and correction coefficients (as applicable) for each channel, 
as well as the date and time of the last calibration. Select a sensor from the Parameter dropdown menu to display its 
calibrations.

The  RBRconcerto3 Tx will have multiple (12 or 24) temperature sensors listed in the Measured channels table, 
and their numbering will start from the end of the string. For example, for a 12-node thermistor string, Channel 
12 will be the node closest to the connector.

Only datasets in Desktop storage format have this option. 
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The main calibration coefficients are displayed as "C" values: C0, C1, C2(K). Dependent coefficients are displayed as "X" 
values: X0, X1, X2, etc. 

You can edit any of the coefficients in your dataset, regardless of the advanced calibration controls settings in 
Preferences.

As soon as you make a change and move to another cell, a new calibration date will be displayed. Also, all three buttons 
at the bottom of the page will become active. 

Use Store and recompute data to recalculate the dataset. Use Revert calibration to recover the previous coefficients 
and data if you have not already selected Store and recompute data.

To revert calibration and recalculation after it was stored, check the Use deployment calibrations checkbox.  Click 
Store and recompute data to save the reverted coefficients.

Parameters

The Parameters tab displays parameters necessary to calculate derived channels and the method used for calculation.
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You can edit these parameters to change the derived channel calculation. As soon as you make a change, the 
two buttons at the bottom of the page will become active. 

Click Update and recompute to recalculate the data and display new values. 

Use Revert settings to recover the previous coefficients and data if you have not already selected Update and 
recompute. 

15.6 File info
The File info page displays the dataset name and download location, Ruskin version used when it was obtained, file 
structure, and size.  

The Structure label reflects the RSK file format, which can be Desktop, Mobile, or Realtime.

Ruskin checks the dataset for compatibility with the 
newest version of Ruskin software. If the file requires 
updating, a warning message and an Update button will 
be displayed.

For Mobile RSK files, you cannot recalculate the data. Clicking Update and recompute will not save the 
changes. 
For Realtime RSK files, the fields are not editable. 
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Click Update. It may take several minutes for it to 
complete. RBR strongly recommends that all datasets 
are updated and meet compatibility requirements.

Failing to update your dataset may result in odd graphical displays and incorrect reporting of the sample 
values.
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16 Plot window
Use the Plot window to view graphical displays of your datasets or live data. When viewing live data, the instrument 
must be attached.  

Each channel appears as a different colour in the plot. These colours are specified under Preferences > Plotting and can 
be changed only there. 

Move the black "double lollipop" cursor from one sample to the next to display parameter values for each sample 
selected. Drag it with your mouse, or use the arrow keys on your keyboard as follows:

 To move by one data sample, press right or left arrow 
 To move by a hundred of samples, press Shift + right arrow or Shift + left arrow
 To move by ten thousand of samples, press Alt + right arrow or Alt + left arrow
 To move by millions of samples, press Shift + Alt + right arrow or Shift + Alt + left arrow

For the datasets, these values will appear in the Properties window above (see Analysis).  For live data, they will be on 
the side of the plot.

The graphical display for each dataset or instrument will be in its own tab.  The dataset file name or the instrument 
model and serial number will appear at the top of the tab. Simulated instruments will have "sim" in front of their name. 

A toolbar at the top right of the Plot window contains various buttons to help you customise, explore, and export the 
graphical display. The buttons selection changes depending on what is displayed in the tab. Hover over a button to 
display its name and function. 



RBR#0006105revQ 91

A downsampled representation of the dataset appears in the thumbnail view, along with an indicator of the current 
plotted time range. 

Position the indicator by clicking on the thumbnail view and dragging the indicator. Resize the indicator by dragging the 
edges left and right. It will zoom the main plot along the time domain to match the new indicator size. See Zoom 
controls for more scaling options. 

When you close and re-open a dataset, it will retain your latest settings (channel visibility, zoom, plot style (plot-by-time 
or plot-by-depth), annotation selection, and display style (lines or markers). Double-click anywhere on the main plot to 
return to the full-chart view.

.

The thumbnail view always shows the plot-by-time data, even if the plot is switched to the plot-by-depth 
mode.

Go to Appearance controls to change your selection of lines and markers. .
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17 Dataset plot toolbar
Use the plot toolbar to adjust the display of an open dataset. 

17.1 Annotation controls
Annotations are information messages added either by users or by the instrument. 

17.1.1 Select annotation type
Annotation types are divided in two categories: profiling (Profile, Downcast, or Upcast) or non-profiling (Comment, 
Exclusion, Location, or Calibration). Use annotation controls to manage this information and to navigate the plot. 

Type Function

Profile, Downcast, Upcast Identify profiling

Comment Add a note to your data

Exclusion Remove a non-representative interval from analysis
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Type Function

Location Add in latitude/longitude coordinates for RSK files to track locations of data 
logging

Calibration Calibrate the ODO sensor

Open the Filter dropdown menu to select the annotation type to display. The 
number of annotations for each type will be indicated. 

Select an annotation type. The plot will centre on the first item in the selected category. For example, when you select 
Profile, the plot will move to the first profile. 

If you switch the filter to another annotation type within the same category (for example, Profile to Upcast), the plot 
will not change. If you switch to a type from another category (for example, from Profile to Comment), the plot will 
move to the first annotation in the new category (for example, to the first comment). 

17.1.2 Navigate between annotations
Use the Navigation buttons to navigate between items within the selected category. 

Navigation controls
 Move from one annotation to another by clicking the left and right arrows.
 Jump all the way to the beginning or end of the list by using the end-left and end-right arrows.
 Alternatively, manually enter the number in the Index field to go to that particular annotation. 
 Double-click an annotation to centre and zoom in the plot at that particular area. .

The navigation buttons will be activated if there is more than one item in the selected annotation type. 
Otherwise, the plot will centre on the only item available. 

Double-click anywhere on the main plot to return to the full-chart view.
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17.1.3 Create new annotation
Click the Create annotation button and follow the steps below. 

Steps

1. Select the type of annotation to create, for example, Comment. The cursor 
in the Plot window will become a two-way arrow.

2. Click on the main plot to identify a single point to comment, or click and 
drag the cursor left or right to select an interval. When you release the click, 
an editable tooltip will open.

The tooltip controls include Left and Right arrows, Delete, Export region, Save, and Close. The Profile tooltip also 
features Up and Down arrows for adding upcast and downcast profiles. 

3. Enter the necessary information into the fields and save by pressing Enter
on your keyboard or by clicking Save on the tooltip. Your new comment 
will appear in the dropdown list.

Clicking Close or pressing Esc on the keyboard will close the tooltip without saving. 

4. Click the arrows on the tooltip to move to the next annotation within the same category. 
5. Double-click on the annotation bar to zoom in to the range of the annotation. 
6. Click and drag on the annotation bar to move the annotation. 
7. Click Delete on the tooltip to delete the annotation.

Edit at least one detail in the tooltip before saving. Otherwise, the annotation will be deleted when 
deselected.  Moving or resizing the annotation counts as editing and saving.
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A warning message will appear. 
Click Delete to proceed. This action cannot be undone.

17.1.4 Add profiles
Use the Annotation function to manually add profiles to your dataset.  

Steps

1. Click the Create annotation button and 
select Profile from the dropdown menu.

2. Click and drag the cursor to select a region.  
As soon as you let go, an editable tooltip will open 
and a band of a darker colour will appear above 
the selection, indicating that a new profile has 
been added.

3. Place the cursor on the edge of this new profile 
and move it left or right to adjust the size. 
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4. Add a name and click Save on the tooltip. 

5. Use the Up and Down arrows on the tooltip to 
identify upcast and downcast regions.
The upcasts and downcasts you added will be 
displayed in the dropdown menu and highlighted 
on the plot under the parent profile.

6. Place the cursor at the edge of the added region 
and adjust its size.

7. Click on a profile/upcast/downcast to open its 
tooltip.  

8. Name each region and save the settings. 

Only the Profile tooltips have the  Up and Down arrows.
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9. If desired, export your profile to a separate RSK file. To do that, click Export region on the Profile tooltip and 
follow the steps.

17.1.5 Export region

Follow the steps below to clip your dataset and export a subset of your data. This function may be useful when you 
need to exclude certain regions. For example, a dataset may contain several deployments if sampling was not paused/
stopped before the new deployment was started. 

Steps

1. Click the Create annotation button and select 
Comment from the dropdown menu.

2. Click and drag the cursor to select a subset. 

3. Enter a name in the Title field on the tooltip and 
click Save. 

The Export region option is not available on Upcast and Downcast tooltips. To generate an RSK file for 
an upcast or downcast section only, use the Comment annotation to clip the dataset before exporting.

The Export region option is only available for Comment and Profile annotations. 
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4. Select Export region on the tooltip. A dialogue 
box will open. 

5. Adjust the name and location for the new dataset 
file and click Save. An Export region message will 
appear.

6. Select No to maintain the full binary values and 
retain the option of recalibration in the future. 
The clipped dataset will open in a new tab in the 
Plot window.

17.2 Cast detection
Ruskin automatically enables profile detection on instruments when a deployment is enabled. There are several criteria 
for enabling this feature.

  The instrument must support the castdetection  setting
  The instrument must have a pressure sensor
  The deployment must be configured for | fast sampling (2Hz and up)
  The deployment mode must be configured as either continuous or directional

It is possible to recalculate the casts in a dataset using the cast detection feature in the Plot view. 
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Click the Cast detection button to run a cast detection algorithm based on depth and conductivity to automatically 
generate profiles and casts. A warning message will appear.

If you proceed, Ruskin will find peaks, collect events, and overwrite profiles recorded by the instrument. .

17.3 Event visibility
Click the Event visibility button to turn on and off the visibility of the various levels of events: Error, Warning, 
Information, and Diagnostic. Its colour will reflect the highest level of event severity reported. 

17.4 Zoom controls
Default scaling of the plot is based on the minimum and maximum values sampled for each channel. Use zoom controls 
to adjust it as needed. 

Double-click anywhere on the main plot to return to the full-chart view.

Double-click anywhere on the main plot to return to the full-chart view.
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17.4.1 Horizontal zoom
Horizontal scale options may be helpful to increase or decrease the time range displayed. It is convenient when the 
dataset is long and thus losing resolution when displayed in the Plot window in its entirety, like in this example. 

There are three ways to apply changes to the horizontal scale.  The first two will auto-range your chart, ensuring the 
entire vertical domain is visible. The third approach will retain the latest vertical scaling of the original interval. 

1. Use the Zoom in horizontally and Zoom out horizontally buttons. 
 OR

2. Click on the thumbnail view and resize the indicator. 
The vertical scale will automatically adjust to fit the new range.

3. Hover your mouse over the X-axis, then hold Shift + left click.
    The cursor will change to a two-way arrow. Drag it right to zoom in or left to zoom out the time domain, without 
changing the data resolution.

Click Reset zoom to maximum bounds or double-click anywhere on the chart to restore the original 
appearance. 
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17.4.2 Vertical zoom
Vertical scale options may be helpful when there are erroneously high or low values that make the real data appear 
incorrect, or when there is significant difference in scale between the displayed parameters.

Entire chart

Depending on the zooming method, you may change the scale only vertically, or both vertically and horizontally. 

1. Use the Zoom in vertically and Zoom out vertically buttons to increase or decrease the resolution of the data 
displayed.
The resulting display will retain the same horizontal scale. 

OR
2. Hover the cursor and scroll your mouse wheel up and down to change the scale.  
In this case, the horizontal scale will also change (as seen from the thumbnail indicator). The plot will centre where 
the mouse cursor initially was. 
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Individual channel

There are two ways to apply changes to the vertical scale of one channel only, which yield the same results.
1. Hover the cursor over the Y-axis for this channel and scroll your mouse wheel up and down.

OR
2. Shift + click the Y-axis for this channel and move your mouse up and down.

This particular channel will zoom in and out (in the example below, temperature).  Double-click on the same vertical 
axis to reset this parameter. 

17.4.3 Navigation options
After you change the scale, some parts of your chart may end up outside the Plot window. There are several options 
available to navigate it. 

1. To pan the entire chart horizontally, hold Ctrl + left click and move your mouse left and right.

This action is only possible after already applying some horizontal zoom to the chart.

Click Reset zoom to maximum bounds or double-click anywhere on the chart to restore the original 
appearance. 



RBR#0006105revQ 103

2. To pan the entire chart vertically, hold Ctrl + left click and move your mouse up and down.

3. To pan one of the channels vertically, click a value on the vertical axis for that parameter (in the example below, 
sea pressure) and move your mouse up and down.

Double-click on the same vertical axis to reset this parameter. 
4. To freely select any part of the chart, hold Shift + left click and draw the rectangle. The chart will zoom in on the 

selected area, both horizontally and vertically. 

5. To keep all  your data within the viewing window, click the Toggle auto-ranging button.  When it is on, all 
profiles within the selected time section maintain their optimal vertical zoom. 
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Click again to disable. Disabling the auto-ranging of the axis can be useful for looking at trends in data. Zooming in or 
out of an individual channel will disable auto-ranging for that channel. 

6. To zoom in to the range of an annotation, double-click on the annotation bar. 

17.4.4 Advanced axis controls

Some RBR instruments have multiple parameters of the same type.  For example, your RSK file from the RBRconcerto3 
Tx could have 12 or 24 temperature channels and from the RBRquadrante, up to four irradiance channels. 

By default, Ruskin will use a single axis to display similar channels. To display each similar channel on its own axis, go to 
Preferences > Plotting > Channel visibility. Deselect the Use single axis for similar channels checkbox. 

Click Apply and close.  These changes will automatically apply to every new dataset. To apply your changes to an active 
dataset, close it and then re-open. 

Both views have their advantages. Below, compare the two displays of the same dataset obtained using an 
RBRquadrante .

Default settings: single axis

The chart displays four irradiance channels and one irradiance axis. The axis is grey, while the traces related to this 
single axis remain colour-coded.

With the axis panel collapsed, you have a broad view of the chart. 

All four channels have the same scale, which in the example below is 0-5.500µW/cm²/nm. Vertical zoom controls, if 
used, are applied to all these traces as a group. 

Click Reset zoom to maximum bounds or double-click anywhere on the chart to restore the original 
appearance. 
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Customised settings: multiple axes

The chart has four irradiance channels and four axes, each identified with the same colour as the trace. The 
corresponding wavelength and FWHM will also be displayed; in this example: 560/10, 488/10, 445/10, and 413/10.

Each channel has its optimal vertical scale. In the example below, the scale for the 560/10 is 0-9.000µW/cm²/nm, while 
for the 413/10 it is 0-0.100µW/cm²/nm .

To adjust the vertical scale for each channel individually, hover the cursor over an axis and scroll your mouse wheel up 
and down. See Vertical zoom for other ways to adjust the scale.

Regardless of the view (single axis or multiple axes), the channel table in the Analysis tab retains individual colours for 
all channels, matching the colour-coding of the traces in the Plot window. 

17.5 Export plot
Click the Export plot button and select file name and location to save the current view of the main plot to a PDF or PNG 
file. The exported file will contain the graph only and retain all the changes to display active at the moment of export: 
zoom, lines and markers, visible events and annotations, and plotting by depth or time.

To change the colour-coding settings for your chart, go to Preferences > Plotting > Channel colours. 
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17.6 Appearance controls

Select your data rendering type from the Change line type dropdown menu:  Lines, Markers, or Lines and markers.

Use the Toggle channel visibility button to open the dropdown menu with the list of available channels and options. 
Check and uncheck channels to display as desired, or select groups to show and hide. 

Select Show raw channels to display measured data with no calibration equations applied. .

If no data appears in the Plot view, try changing the rendering to Markers.  Time spans that are larger than 
expected will cause breaks between data points and lines will not be drawn connecting those points, whereas 
markers draw at each individual point.
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By default, the data are plotted by time. Use the Toggle depth plot button to switch to the plot-by-depth mode.

The thumbnail view will continue to display the plot-by-time data. 

17.7 GPS map

The Show GPS map button opens a pop-up window with the GPS map for the 
plot. Click on the map to display all the GPS location annotations recorded in the 
dataset.

GPS mapping for Desktop RSK files relies on manually added location points (see 
Annotation controls). All location points you added using the Annotations feature 
are stored in the dataset file and can be displayed in Ruskin via the mapping 
functionality.

If there is no depth channel, the plot will use the next pressure or pressure-derived channel starting from the 
bottom of the channel list.

Charting and continuous GPS tracking are only available on the Ruskin Mobile app, for datasets in the Mobile
storage format.  
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18 Live data plot toolbar
You can use the Plot window to view a live graphical display of your instrument sampling. All options described in the 
Dataset plot toolbar section apply to live data display. Additionally, three live data buttons appear at the right end of 
the toolbar: Side data panel, Live plot time range, and Fetch. 

Click the Side data panel button to toggle on and off the data panel to the right of the plot. It shows the file location 
that will be used to capture samples, the number of samples collected, the values of the last received sample, and the 
currently selected sample.  

Click the Live plot time range button to open a dropdown list of time span options. For example. select 2 minutes to 
display the data in the thumbnail view and on the side panel by two-minute time periods.

You can also choose to display all of the data collected.
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Fetching

Live data can come from one of two sources: streaming or fetching. 

Fetching is the action of asking the instrument to take a reading and report it. 

Fetching can be used on an instrument that is either not enabled or enabled without a streaming option. To disable the 
streaming option, go to Options under the Configurations tab and set Realtime to None.

Click the Fetch button to start fetching data. The button will change to Pause. Click the Pause button to stop fetching. 

If the instrument is fetching data, but you want to start streaming, go to Options under the Configurations tab and set 
Realtime to Serial or USB, then click Enable. A warning message will appear. 

To save the fetched data, click Cancel and download the dataset file. Otherwise, click Erase and enable logging. 

Ruskin will disable fetching, close the current dataset used for the fetched data, and create a new file for the streamed 
data. A new streaming plot will appear. Click the Pause button to freeze the view of live data. 

If streaming is selected (Realtime is set to Serial or USB), clicking the Fetch button will have no effect on the 
plot. 
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19 Firmware updates
Ruskin automatically checks if your instrument firmware is up-to-date. Updates may be critical, routine, or customised. 

19.1 Critical firmware updates
If a newer version is available and this update is critical, the Update firmware button and a warning message will 
appear at the top of the Configuration tab. 

Steps

1. Click Update firmware.
The Update logger firmware window will 
appear. It will contain Release notes, outlining 
the new version number, its release date, 
improvements, and bug fixes associated with this 
release, and two standard buttons at the bottom 
of the window: Close and Proceed. 

2. Click Proceed to initialise the update.
The instrument will disappear from the Navigator
window during the upgrade. Watch the progress 
bar at the bottom of the window for the status. 

Do not disconnect the instrument until a confirmation message is displayed. Disconnecting during the update 
process may render the instrument inoperable.
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If the upgrade does not complete successfully, go to the 
Instruments menu and launch the update dialogue.

The Update logger firmware window will appear. Click Proceed again to retry. 

If the instrument does not reappear in the Navigator window after a firmware update, disconnect your instrument from 
the USB port and then reconnect to establish communication.

19.2 Routine firmware updates
If the latest update is not critical, Ruskin will not display any warning message. However, you can always check 
manually if a newer firmware version is available.

Go to Instruments > Update instrument firmware.

The Update logger firmware dialog box will appear. In addition to the new version number, its release date, 
improvements, and bug fixes, there will be two additional sections: Select the instrument to update and Select the 
firmware image. 

Steps

1. From the Instrument dropdown, select the 
instrument you wish to upgrade.

2. From the next dropdown, select the latest 
firmware image.   

3. Click Proceed to initialise the update.
The instrument will disappear from the Navigator
window during the upgrade. Watch the progress 
bar at the bottom of the window for the status.  
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If the upgrade does not complete successfully, click Proceed again to retry. 

If the instrument does not reappear in the Navigator window after a firmware update, disconnect your instrument from 
the USB port and then reconnect to re-establish communication.

19.3 Manual firmware updates
In certain cases, RBR may supply a customised firmware version, which will not be on the dropdown list. 

Go to the Instruments menu and launch the update 
dialogue.

The Update logger firmware dialog box will appear.  Follow the steps below to import the firmware image provided by 
RBR and update your firmware. 

Steps

1. In the Update logger firmware dialog box, click 
Import.

2. Browse to the location of the firmware update file. 
The file will have the extension .rbrfw.

3. Select the file and click Open.
The file will appear on the dropdown list. 

4. Click Proceed to initialise the update.
The instrument will disappear from the Navigator
window during the upgrade. Watch the progress 
bar at the bottom of the window for the status.  

Do not disconnect the instrument until a confirmation message is displayed.
Disconnecting during the update process may render the instrument inoperable.

Do not disconnect the instrument until a confirmation message is displayed. Disconnecting during the update 
process may render the instrument inoperable.
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20 Automatic tasks
When working with a large number of similar instruments, Ruskin offers various automatic tasks.

When using this feature, you will configure your schedule once and then automatically apply the settings to multiple 
instruments.

Access these options from the Instruments menu on the 
top toolbar.

Alternatively, right-click Instruments in the Navigator
window. 

When you enable a task, it will show a checkmark next to 
it, and the corresponding icon will be displayed in the 
Navigator window. 

Since these tasks can change the state of your instrument, their settings default to "off" each time Ruskin is run.  

When an automatic task is on, Ruskin will execute it as soon as you plug an instrument into your computer. 

Automatic tasks do not work with wi-fi connected instruments.
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Auto-download

When Ruskin detects an instrument, it will automatically start a download process. The downloaded dataset will be 
named following the standard naming convention, and saved in the default directory. Other than possibly creating 
unwanted files, this option is safe since it does not alter the state of the instrument.

Auto-stop

When Ruskin detects a previously enabled instrument, it will automatically stop the deployment.  If auto-download is 
not selected, it will also display a warning about downloading the instrument data. 

Use this feature when Gating is set to None. 

Auto-deploy

When Ruskin detects an instrument, it will stop the deployment and then reprogram your instrument with the last 
known configuration settings. Use this feature when you have several instruments with the same capabilities. 

To use this feature, follow these steps:
1. Connect to an instrument that will act as the model.
2. Configure this instrument with the desired settings.
3. Enable Auto-deploy as shown above.

Now, when you connect to an instrument with same capabilities as the model instrument, Ruskin will configure it to 
match the the model schedule. 

View auto-deploy settings

To view the currently active auto-deploy parameters, go to Instruments > View auto-deploy settings....

The Auto-deploy settings box will open, with saved parameters outlined. 

All the data on the instrument will be erased as soon as you enable a new deployment.  RBR recommends 
enabling the Auto-download feature whenever you enable Auto-stop. 

All the data on the instrument will be erased as soon as you enable a new deployment.  RBR recommends 
enabling the Auto-download feature whenever you enable Auto-deploy. 

Auto-deploy implies Auto-stop.
Ruskin must stop your instrument to change deployment parameters, so it will stop even when there is no 
checkmark next to the Auto-stop task. 
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21 Utilities

From the Instruments menu, click Utilities. A dropdown menu will open. 

Stop instrument upon detection

This is an emergency utility which provides a solution to a rare issue with some 
legacy instruments. Do not use unless instructed by RBR. 

Connect to networked device...

This utility allows a device with serial output to connect to your network via Ethernet. This feature supports remote 
management and monitoring of your instruments from anywhere in the world.

1. Select your network device from the dropdown list.

2. Specify the IP address and port. 

The Utilities option is a support tool. Contact RBR before using it. 

mailto:support@rbr-global.com
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3. Click Connect.
The Connections tab will display instruments and salinometers connected 
via Ethernet, alongside with the instruments physically plugged in to your 
computer. Their IP address and port will appear in the Port column. If an 
attempt to connect was unsuccessful, Ruskin will report an error in the 
Status column. 

To view connected GPS devices, go to the next utility. 

View connected GPS...

This feature allows you to track your instruments during towed deployments. Attach a NMEA GPS to your computer and 
connect to it as described above. Alternatively, connect to one of the boat tracking devices if it has an IP address.

Typically, only one GPS is necessary to track your deployment. Using more than 
one GPS may bring confusion into your data. Click View connected GPS... to see 
all listening ports. Click the Port button to disconnect. 
.

For the microsalinometer, the port number must be 23. 
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22 User calibration
Factory calibration coefficients are calculated for each sensor, and the coefficients are stored on the instrument. 

RBR calibration certificates contain calibration equations, coefficients, and residuals for each sensor.

Calibration certificates are available for download:
 If using Ruskin, connect your instrument and go to Information, then select Download.
 For OEM instruments, go to https://oem-lookup.RBR-global.com, select OEM lookup by serial number, and 

search by the serial number and authorisation key.

RBR recommends calibrating your instrument before any critical deployment, periodically once a year, or if you suspect 
the readings to be out of specifications.

Discuss your calibration requirements with RBR. In some cases, the instrument will need to be returned to RBR to have 
it checked and recalibrated.

Please contact RBR for our current calibration fees.

View current calibration coefficients for your sensors under the Calibration tab in the Properties window. 

Sensors such as dissolved oxygen, turbidity, pH, and fluorescence can be field-calibrated.  Update the calibration 
coefficients for these channels periodically. On occasion, you may need to manually enter new coefficients, although 
this is not recommended for factory-calibrated sensors (for example C, T, or D) unless instructed by RBR. 

To calibrate a sensor, you need to let it sample in a known environment and then compare the result to the established 
value.  The difference will be used to generate calibration coefficients. With the N-point method, the known 
environment is changed N times. The higher the N, the more accurate are calibration coefficients. 

Use the Calibration button under the Analysis tab to calibrate turbidity, pH, fluorescence, and OxyGuard DO sensors.

Use the Plot window to calibrate the RBRcoda3 T.ODO and RBRcoda Tu integrated sensors. 

When performing a one-point calibration, Ruskin will adjust the coefficients as follows.

Zero-point calibration:

Non-zero point calibration: 

22.1 Dissolved oxygen sensor calibration

Dissolved oxygen sensors manufactured by RBR are available as the RBRcoda3 T.ODO and can be integrated in any RBR 
standard instrument. Additionally, RBR standard instruments support several third-party dissolved oxygen sensors 
(OxyGuard, Rinko, and Aanderaa). 

  Use only datasets in the Desktop storage format to calibrate the sensors.  The Calibration tab is not available 
for RSK files in the Mobile storage format.

 Use only datasets in Desktop storage format to calibrate the sensors. The Calibration tab is not available 
in Mobile mode.

https://oem-lookup.RBR-global.com
mailto:support@rbr-global.com
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For dissolved oxygen sensors, RBR recommends user calibration using the N-point method, with N = 2, which will 
include a zero reference point and a non-zero reference point. It is, however, acceptable to perform a one-point 
calibration.  

22.1.1 Dissolved oxygen data collection
The steps to obtain the calibration dataset are the same for DO and ODO sensors. The only difference is that optical 
sensors must be hydrated before use. Thus, if you store it with a wet storage cap on, your instrument is ready for 
calibration any time. However, if you store it dry, rehydrate your sensor for five days. It takes at least three days for a dry 
ODO sensor to equilibrate after being placed in water. Insufficient hydrating time may lead to unreliable data. .

See "RBR ODO sensor care and maintenance" section in the RBR Standard Instrument Guide for more details. The Guide 
is available on Ruskin under Help > Documentation. 

The RBRcoda3 DO instruments with galvanic dissolved oxygen sensors manufactured by OxyGuard do not need 
hydrating. 

Equipment and materials
 A wide-mouth, black-walled container with a cover
 A small container or beaker
 Air pump (for example, an aquarium air pump with a stone bubbler) 
 Magnetic stirrer
 Sodium sulphite Na2SO3
 Distilled water

Ruskin configuration
1. Go to Configuration .
2. Select UTC or Local, depending on your preferences, to synchronise the instrument clock with your computer.
3. Set the sampling rate at 1s (1Hz).
4. Enable your schedule.

Non-zero reference point

1. Fill the black-walled container with distilled water.
2. Install the magnetic stirrer.
3. Install the air pump.
4. Switch on both the air pump and the magnetic stirrer.
5. Leave them on overnight, or for at least 3-4 hours, to achieve saturation. 
6. Submerge the dissolved oxygen sensor in the solution, going in at an angle 

and stirring to avoid bubble buildup on the sensor window. 
Leave some space between the sensor and the beaker walls. 

7. Position the sensor near the stirrer but not directly in the bubbles.
The bubbler should be shallower than the sensor.

8. Record the data for at least 30 minutes.
This is the 100% oxygen concentration calibration point.

Rehydrate the RBRcoda3 T.ODO for five days before collecting data.

The instrument must be logging throughout the calibration procedure.
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Zero reference point

1. In a small container or beaker, prepare a 0.1% solution of sodium sulphite 
(0.25g of Na2SO3 for 250mL tap water). 

2. Mix the solution thoroughly with a magnetic stirrer. The solution will be 
oxygen-free after 15 minutes. 

3. Submerge the dissolved oxygen sensor in the solution, going in at an angle 
and stirring to avoid bubble buildup on the sensor window. 
Leave some space between the sensor and the beaker walls. 

4. Record the data for at least 30 minutes.
This is the 0% oxygen concentration calibration point.

22.1.2 DO calibration in Analysis tab
For DO sensors, RBR recommends a two-point user calibration, which includes a zero reference point and a non-zero 
reference point. It is, however, acceptable to use a one-point calibration. 

Two-point calibration steps on Ruskin 

1. Stop the deployment.

2. Download the dataset.

3. Open the dataset on Ruskin. The Properties
windows will change to dataset properties, with 
the Analysis tab displayed.

4. Click Calibration. 

5. Select Dissolved O2 saturation  from the 
dropdown list.
By default, the Number of samples  is set to 100, 
which means Ruskin will average the calibration 
coefficients over a hundred sample points. 
Typically, this value should be in the range from 
50 to 100 samples.
The Raw channel box is unchecked, and thus the 
true DO values will be displayed in the plot below. 
To see the raw voltage values, check this box. 

A downsampled representation of the dataset will 
appear in the thumbnail view, with two distinct 
plateaus corresponding to 100% and 0%. Irregular 
readings in-between mark the times when you 

Omit this step when performing the one-point calibration. 
If you calibrate your dissolved oxygen sensor using the one-point calibration method at 100% oxygen 
concentration only, calibration should be performed at the expected temperature and salinity of the 
deployment environment.

This Na2SO3 solution has a limited lifespan and should not be used for more than a day. 
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changed from distilled water to sodium sulphite 
solution and reassembled the setup. 

6. Click on a stable point in the Plot view 
corresponding to 100% oxygen. 
The interval of 100 samples will be highlighted. 
The average value (Avg) and standard error (Std) 
for this interval will appear in the table above. 

7. Under Real Avg  in the first row, enter 100. 

8. Repeat the same steps for the second plateau, entering 0 under Real Avg.

9. Ruskin automatically calculates the calibration 
coefficients, and the values appear in Calculated 
coefficients. 

10. Click Copy to save the new calibration coefficients to the clipboard, or write them down.
11. In the Navigator view, find your instrument.
12. Click Calibration and select Dissolved O2 saturation  from the dropdown list. 
13. Click C0 to select the entry field and type in the new value (in this example, -2.6351535 ). 
14. Click C1  to select the entry field and type in the new value (in this example, 1.0794960 ).
15. Click Store calibration to save the new coefficients. 

Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost 
once your session is closed. 
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One-point calibration steps on Ruskin

1. Stop the deployment.
2. Download the dataset.
3. Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab 

displayed.
4. Click Calibration. 
5. Select Dissolved O2 saturation from the dropdown list.
6. Check the 1 point calibration box. 
7. Click on a stable point in the Plot view corresponding to 100% oxygen. 

The interval of 100 samples will be highlighted. The average value (Avg) and standard error (Std) for this interval 
will appear in the table above. 

8. Click the RealAvg column and select 100 from the dropdown. 
9. Click Copy to save the new calibration coefficients to the clipboard, or write them down.

10. In the Navigator view, find your instrument.
11. Click Calibration and select Dissolved O2 saturation from the dropdown list. 
12. Click C0 to select the entry field and type in the new value. 
13. Click C1 to select the entry field and type in the new value.
14. Click Store calibration to save the new coefficients. 

22.1.3 ODO calibration in Plot window

Plot calibration steps on Ruskin

Use the Plot window on Ruskin to calibrate your RBRcoda3 T.ODO. You can choose a one-point (100% O2) or a two-
point  (100% and 0% O2) method.

1. Create a new calibration region.
a. Obtain the calibration dataset as 

described above and open it in Ruskin. 
b. Click Create annotation and select 

Calibration from the dropdown menu. 
The cursor in the Plot window will become 
a two-way arrow.

c. Click and drag left or right to select the 
calibration region. 
The interval will be highlighted and a 
tooltip will open. 

d. Enter the title for the region and select 
Dissolved O2 concentration from the 
dropdown menu.

If you calibrate your dissolved oxygen sensor using the single-point calibration method at 100% oxygen 
concentration only, calibration should be performed at the expected temperature and salinity of the 
deployment environment.

Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost 
once your session is closed. 

Optical dissolved oxygen sensors manufactured by RBR are calibrated using the Plot window.  Clicking the 
Calibration button under the Analysis tab will result in an error message.
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e. Press Enter on your keyboard or click 
Save on the tooltip to save the calibration 
region. A section for this calibration region 
will open under Cursor. 

f. To delete a calibration region, 
click Delete on the tooltip. A warning 
message will appear.

2. Create plateaus.
a. Click Detect plateaus. If there are existing 

plateaus, a warning message will appear.
b. Click Proceed to continue. All detected 

plateaus will be visible as grey markers 
under the calibration region marker.  

c. To create a plateau manually, click Create 
plateaus.
A new plateau will appear as a grey marker 
at the start of the calibration region 
marker. Each new click will add another 
plateau to the right of the existing one.

d. Click a plateau to open its tooltip. You can 
now edit the title and add reference 
values.

e. To delete a plateau, click Delete on the 
tooltip. A warning message will appear.
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3. Enter reference data.
a. By default, Reference is set to Manual

entry mode, with in units of % or  μm ol/L 
available in the dropdown menu.
Enter the reference value for each plateau 
manually in the Plateau table under 
Cursor, or in the Plateau tooltip.

b. Alternatively, enter reference values from 
the CSV file. The CSV file for the automatic 
data entry must have two columns: time 
(in ISO 8601 format) and data (in float/
double format).
Once the file has been selected, a dialogue 
box will appear asking for you to define 
which column contains the time and which 
contains the reference values.

4. Save the coefficients.
a. Verify that the calibration was successful.

If the residuals are within an acceptable 
range, they will be highlighted in green, 
and the Save button will appear in the 
Calculated coefficients section.

b. Click Save to write the coefficients to the 
instrument. The instrument must be 
connected to Ruskin.

If successful, a success message will appear. 

If not, a warning message will appear instead. 

22.2 Turbidity sensor calibration

The time in the CSV file will need to be a value that falls within the region of the plateau.
However, the CSV file can hold additional rows with times that are outside of the plateau region.

Calibration coefficients are stored on the instrument and not the sensor.  Recalibrate your sensor if you move 
it to a different instrument. 

 Use only datasets in Desktop storage format to calibrate the sensors. The Calibration tab is not available 
in Mobile mode.
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Turbidity sensors manufactured by RBR are available as the RBRcoda Tu and can be integrated in any RBR standard 
instrument. Additionally, RBR standard instruments support several third-party turbidity sensors. User calibration is 
available for RBRcoda Tu, Seapoint®, and Turner® sensors.

RBR factory-calibrates the turbidity sensors using the N-point method, with N = 2. For user calibration, we also 
recommend using the two-point method (N = 2) performed with protection from ambient light.

Alternatively, you can perform a one-point calibration using a single zero reference point in distilled water. Calibration 
will only correct the coefficients for an offset. 

22.2.1 Tu data collection
Follow the steps below to obtain the calibration dataset for your Tu sensor. 

Equipment and materials
 A wide-mouth, black-walled container (large enough to hold the instrument 15-20cm away from the walls)
 Secure black lid for the container with an orifice for the instrument
 Small black lid or any light-blocking material to cover the orifice during calibration
 1000FTU Formazin standard (800-1000FTU will work)
 Optional: 4000FTU Formazin standard (for the optical backscatter channel - RBRcoda Tu only)
 Distilled water
 Large magnetic stirrer
 Rubbing alcohol
 Soft cloth

Ruskin configuration

1. Go to Configuration.
2. Use Local on Ruskin to synchronise the instrument clock with your computer.
3. Set the sampling rate to 4Hz for RBRcoda Tu, 3s for Seapoint®, or 11s for Turner®.
4. For Seapoint® or Turner®, go to Ranging sensors and set Range to Auto. 
5. Enable your schedule.

Sensor preparation
1. Wash the sensor and container with distilled water and dry them with a soft cloth.
2. Check the turbidity window for stains and scratches. 

3. Wipe the  turbidity window with alcohol to remove all stains.  

When performing the one-point method,  use only a zero reference point.
With a single non-zero reference point, calibration will recompute the slope coefficient.  Go this route only if 
you are confident in your non-zero standard.

The RBRcoda Tu has two channels, turbidity and optical backscatter. It is not mandatory to calibrate both if 
you are only using one. However, if you are using the OBS channel and need to calibrate it, use two non-zero
reference points. 

Calibrate the RBRcoda Tu only as a standalone sensor. Disconnect it from the multi-channel logger and 
connect to Ruskin using a cable. 

Do not proceed with calibration if there are serious scratches.
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Zero reference point

1. Fill the black-walled container with distilled 
water.

2. Turn on the magnetic stirrer and adjust the RPM 
to ensure no vortex appears. 

3. Place the black lid on the container and avoid 
direct light on the container.

4. Submerge the sensor though the orifice in the lid, 
vertically along the wall,  with the turbidity 
window facing the larger water volume. 

5. Cover the orifice with the smaller black lid or 
light-blocking material, like a thick plastic bag. 

6. Record the data in distilled water for at least 
15min, up to 45min. 
This is the zero-turbidity calibration point.

Non-zero reference point

Repeat the steps for the zero reference point, replacing distilled water with 1000FTU Formazin standard.

This is the 1000NTU calibration point.

As each reference point takes 15 minutes to an hour, the entire procedure may take up to two hours. 

After completing the procedure for both reference points (or for a single reference point, if using the one-point method), 
proceed to calibration on Ruskin. 

22.2.2 Tu calibration in Analysis tab
For turbidity calibration, we recommend using the two-point method, which includes a zero reference point and a 
non-zero reference point.

It is, however, acceptable to use a one-point calibration.

The distance from the turbidity window to the 
container wall must be 15-20cm. 

If a non-zero reference solution is produced by diluting concentrated Formazin, stir until stable.

If you are calibrating the OBS channel (RBRcoda Tu), repeat these steps for one more non-zero point 
(4000FTU).  Thus, you will have two non-zero points (1000FTU and 4000FTU), but no zero points.
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Two-point calibration steps on Ruskin

1. Stop the deployment.
2. Download the dataset.
3. Open the dataset on Ruskin. The Properties

windows will change to dataset properties, with 
the Analysis tab displayed.

4. Click Calibration. 
5. Select Turbidity from the dropdown list.

By default, the Number of samples is set to 100, 
which means Ruskin will average the calibration 
coefficients over a hundred sample points. 
Typically, this value should be in the range from 
50 to 100 samples.
The Raw channel box is unchecked, and thus the 
true turbidity values will be displayed in the plot 
below. To see the raw voltage values, check this 
box. 
A downsampled representation of the dataset will 
appear in the thumbnail view, with two distinct 
plateaus corresponding to zero NTU and 400NTU. 
Irregular readings in-between mark the times 
when you changed from water to formazin and 
reassembled the setup. 

6. Check the box next to the first row in the 
calibration table. 

7. Click on a stable point in the Plot view 
corresponding to zero NTU. 
The interval of 100 samples will be highlighted. 
The average value (Avg) and standard error (Std) 
for this interval will appear in the table above. 
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8. Under Real Avg in the first row, enter 0 and press 
enter. 

9. Repeat the same steps for the second plateau, 
entering 400 under Real Avg.

10. Ruskin automatically calculates the calibration 
coefficients, and the values appear in Calculated 
coefficients. 

11. Click Copy to save the new calibration coefficients to the clipboard, or write them down.
12. In the Navigator view, find your instrument.
13. Click Calibration and select Turbidity from the dropdown list. 
14. Click C0 to select the entry field and type in the new value (in this example, 3492.6945 ). 
15. Click C1 to select the entry field and type in the new value (in this example, -4767.0838).
16. Click Store calibration to save the new coefficients. 

One-point calibration steps on Ruskin
1. Stop the deployment.
2. Download the dataset.
3. Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab 

displayed.
4. Click Calibration. 
5. Select Turbidity from the dropdown list.
6. Check the 1 point calibration box. 
7. Click on a stable point in the Plot view corresponding to 0NTU. 

The interval of 100 samples will be highlighted. The average value (Avg) and standard error (Std) for this interval 
will appear in the table above. 

8. Click the RealAvg column and select 0 from the dropdown. 

When a two-point calibration is performed correctly, residuals will be 0. 

Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost 
once your session is closed. 
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9. Click Copy to save the new calibration coefficients to the clipboard, or write them down.
10. In the Navigator  view, find your instrument.
11. Click Calibration and select Turbidity from the dropdown list. 
12. Click C0 to select the entry field and type in the new value. 
13. Click C1 to select the entry field and type in the new value.
14. Click Store calibration to save the new coefficients. 

22.2.3 Tu calibration in Plot window

Plot calibration steps on Ruskin

Use the Plot window on Ruskin to calibrate your RBRcoda Tu. You can choose a one-point (1000FTU) or a two-point  
(distilled water and 1000FTU) method.

1. Create a new calibration region.
a. Obtain the calibration dataset as 

described above and open it in Ruskin. 
b. Click Create annotation and select 

Calibration from the dropdown menu. 
The cursor in the Plot window will become 
a two-way arrow.

c. Click and drag left or right to select the 
calibration region. 
The interval will be highlighted and a 
tooltip will open. 

d. Enter the title for the region and select the 
channel to calibrate from the dropdown 
menu: Turbidity 880nm or Turbidity OBS 
880nm.

e. Press Enter on your keyboard or click 
Save on the tooltip to save the calibration 
region. 
A section for this calibration region will 
open under Cursor. 

f. To delete a calibration region, 
click Delete on the tooltip.
A warning message will appear.

Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost 
once your session is closed. 

Turbidity sensors manufactured by RBR are calibrated using the Plot window.  Clicking the Calibration button 
under the Analysis tab will result in an error message.
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2. Create plateaus.
a. Click Detect plateaus

If there are existing plateaus, a warning 
message will appear.

b. Click Proceed to continue. 
All detected plateaus will be visible as grey 
markers under the calibration region 
marker.  

c. To create a plateau manually, click Create 
plateaus
A new plateau will appear as a grey marker 
at the start of the calibration region 
marker. Each new click will add another 
plateau to the right of the existing one.

d. Click a plateau to open its tooltip. You can 
now edit the title and add reference 
values. 

e. To delete a plateau, click Delete on the 
tooltip.
A warning message will appear.

3. Enter reference data.
a. By default, Reference is set to 0.0 entry 

mode. Enter the reference value for each 
plateau manually in the Plateau table 
under Cursor, or in the Plateau tooltip

b. Alternatively, enter reference values from 
the CSV file. The CSV file for the automatic 
data entry must have two columns: time 
(in ISO 8601 format) and data (in float/
double format).
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Once the file has been selected, a dialogue box will 
appear asking for you to define which column contains 
the time and which contains the reference values.

4. Save the coefficients.

a. Verify that the calibration was successful.
If the residuals are within an acceptable range, they 
will be highlighted in green, and the Save button 
will appear in the Calculated coefficients section.

b. Click Save to write the coefficients to the 
instrument. The instrument must be connected to 
Ruskin.

If successful, a success message will appear. 

If not, a warning message will appear instead. 

22.3 pH sensor calibration

RBR standard instruments support combination glass pH electrode sensors.

For pH sensors, RBR recommends user calibration using the N-point method, with N = 3. Calibrate the pH sensors 
before each deployment, using three buffer fluids for optimum accuracy. For best results, perform in a temperature-
controlled bath at 25°C, with a marine thermistor in the bath. 

22.3.1 pH data collection
Follow the steps below to obtain the calibration dataset for your pH sensor. 

Equipment and materials
 Wide-mouth beaker or any container (large enough to maintain adequate distance from the sensor face to the 

wall)
 Narrow-mouth beaker which can fit both the pH and reference sensors
 Submersible magnetic stirrer (optional)

The time in the CSV file will need to be a value 
that falls within the region of the plateau.
However, the CSV file can hold additional rows 
with times that are outside of the plateau 
region.

 Use only datasets in Desktop storage format to calibrate the sensors. The Calibration tab is not available 
in Mobile mode.

Use the three-point calibration method:
 To check the zero point, use a pH 7 buffer fluid. 
 To set the slope, use an acidic and a basic buffer. RBR uses pH 4 and pH 10 buffer fluids to set the slope.
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 Submersible magnetic stirrer pad (optional)
 Clean tap water
 pH 4, pH 7, and pH 10 buffer fluids
 Marine thermistor (on your instrument)

Ruskin configuration
1. Go to Configuration.
2. Use Local on Ruskin to synchronise the instrument clock with your computer.
3. Set the sampling rate to the fastest rate possible for the instrument.
4. Enable your schedule.

Temperature bath preparation
1. Fill the larger beaker with warm tap water (at 25°C).
2. Submerge the marine thermistor in the bath.
3. Optionally, place the magnetic stirrer at the bottom. Use the submersible magnetic stirrer pad to adjust the 

stirrer height.

Buffer bath procedure

1. Fill the smaller beaker with pH 4 buffer fluid.
2. Rinse both the pH sensor and reference sensors 

with clean water, then with pH 4.
3. Warm up the beaker in your hand or in warm 

water.
4. Submerge both the pH and reference sensors in 

the same pH 4 buffer solution. 
If using the magnetic stirrer, position your sensors 
near it, as that is in the best-mixed area of the 
bath. 

5. Stir for 30 minutes or until the pH and 
temperature signals have stabilised.

Repeat with pH 7.

Repeat with pH 10.

As each buffer fluid procedure takes at least 30 minutes, the entire procedure takes about two hours. 

After collecting the measurements for each buffer fluid, proceed to calibration on Ruskin. 

22.3.2 pH calibration in Analysis tab
For pH calibration, we recommend using the three-point method. The dataset will have three distinct plateaus.

The instrument must be logging throughout the calibration procedure.

The buffer bath steps are repeated three times, each time with a new buffer fluid: pH 4, pH 7, and pH 10. Buffer 
fluids are colour-coded, so it is easy to keep track of the steps. 
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Calibration steps on Ruskin

1. Stop the deployment.
2. Download the dataset.
3. Open the dataset on Ruskin. The Properties

windows will change to dataset properties, with 
the Analysis tab displayed.

4. Click Calibration. 
5. Select pH from the dropdown list.

By default, the Number of samples is set to 100, 
which means Ruskin will average the data points 
for the calibration over a hundred sample points.
Use the up and down arrows to adjust this value. 
Typically, it should be in the range from 20 to 100 
samples, depending on the sampling rate. For 
16Hz, select 100. For 2Hz, select 20. 
The Raw channel box is unchecked, and thus the 
true pH values will be displayed in the plot below. 
To see the raw voltage values, check this box. 

A downsampled representation of the dataset will 
appear in the thumbnail view, with three distinct 
plateaus corresponding to pH 4, pH 7, and pH 10. 
Irregular readings in-between mark the times when 
you changed the buffer fluid and reassembled the 
setup. 

6. Check the box next to the first row in the 
calibration table. 

7. Inspect the plateau for possible trends and 
irregularities.

8. Click on a stable point in the Plot view 
corresponding to pH 4.  Ensure the selected 
region is stable (within 0.005pH).

The interval of samples will be highlighted. The 
average value (Avg) and standard error (Std) for 
this interval will appear in the table above the 
plot. 
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9. Under Real Avg in the first row, enter 4 and press 
enter. 

10. Repeat the same steps for the second plateau, 
entering 7 under Real Avg.

11. Repeat the same steps for the third plateau, 
entering 10 under Real Avg.

12. Ruskin automatically calculates the calibration 
coefficients, and the values appear in Calculated 
coefficients. 

13. Click Copy to save the new calibration coefficients to the clipboard, or write them down.
14. In the Navigator view, find your instrument.
15. Click Calibration and select pH from the dropdown list. 
16. Click C0 to select the entry field and type in the new value (in this example, -37.0902940). 
17. Click C1 to select the entry field and type in the new value (in this example, 86.8804900).
18. Click Store calibration to save the new coefficients. 

22.4 Fluorometer calibration

RBR standard instruments support third-party fluorescence sensors. Fluorometers are factory-calibrated using the 
N-point calibration method; typically, with N = 3. User calibration is available only for fluorescence sensors
manufactured by Turner®.

Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost 
once your session is closed. 

 Use only datasets in Desktop storage format to calibrate the sensors. The Calibration tab is not available 
in Mobile mode.
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You can perform a one-point calibration (N = 1) and establish a new zero reference point to account for drift or damage 
to the face of the sensor (offset correction). If the readings are too far from the expected value, contact RBR for help. 
You may have to return the instrument to RBR for a full calibration.

Alternatively, you can perform a two-point calibration (N = 2) , which includes a zero reference point and a non-zero 
reference point. This method can help you align a new fluorometer with your previous research standards.

22.4.1 Fluorescence data collection
Follow the steps below to obtain the calibration dataset for your fluorometer. 

Equipment and materials
 A wide-mouth, black-walled container (large enough to maintain adequate distance from the sensor face to the 

wall)
 Black lid for the container
 Distilled water
 Rubbing alcohol
 Soft cloth

Ruskin configuration
1. Go to Configuration.
2. Use Local on Ruskin to synchronise the instrument clock with your computer.
3. Set the sampling rate to the fastest rate possible for the instrument.
4. Under Ranging sensors, set Range to Auto. 
5. Enable your schedule.

Sensor preparation
1. Wash the sensor and container with distilled water and dry them with a soft cloth.
2. Check the sensor window for discolouration and scratches.

3. Wipe the sensor window with alcohol.

Zero reference point

1. Fill the black-walled container with distilled 
water.

2. Fully submerge the sensor. 

3. Record the data for five minutes. This is the zero 
calibration point.

The instrument must be logging throughout the calibration procedure.

Do not proceed with calibration if there are serious scratches.

The distance from the sensor window to the 
container wall must be at least 20 cm. 

mailto:support@rbr-global.com
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Non-zero reference point

To perform a two-point calibration, you will need your own standard non-zero point obtained using reference 
fluorescence solutions such as rhodamine dye or fluorescein, or environmental samples with known chlorophyll 
concentration. Collect these data in a setting of your choosing. 

22.4.2 Chlorophyll a calibration in Analysis tab
Use a one-point method to calibrate your fluorometer for offset correction, establishing a new zero reference point. 

Alternatively, you can perform a two-point calibration, which includes a zero reference point and a non-zero 
reference point. This method can help you align a new fluorometer with your previous research standards.

One-point calibration steps on Ruskin

1. Stop the deployment.
2. Download the dataset.
3. Open the dataset on Ruskin. The Properties

windows will change to dataset properties, with 
the Analysis tab displayed.

4. Click Calibration. 
5. Select Chlorophyll a from the dropdown list.

By default, the Number of samples is set to 100, 
which means Ruskin will average the calibration 
coefficients over a hundred sample points. 
Use the up and down arrows to adjust this value. 
Typically, it should be in the range from 20 to 100 
samples, depending on the sampling rate. For 
16Hz, select 100. For 2Hz, select 20.
The Raw channel box is unchecked, and thus the 
true chlorophyll a values will be displayed in the 
plot below. To see the raw voltage values, check 
this box.

A downsampled representation of the dataset will 
appear in the thumbnail view, with a plateau at 
0µg/L. 
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6. Check the 1 point calibration box. 
7. Click on a stable point in the Plot view 

corresponding to 0µg/L. 
The interval of 100 samples will be highlighted. 
The average value (Avg) and standard error (Std) 
for this interval will appear in the table above. 

8. Click the RealAvg column and select 0 from the 
dropdown. 
The new calibration coefficients will be displayed 
under the table. 

9. Click Copy to save the new calibration coefficients to the clipboard, or write them down.
10. In the Navigator view, find your instrument.
11. Click Calibration and select Chlorophyll a from the dropdown list. 
12. Click C0 to select the entry field and type in the new value. 
13. Click C1 to select the entry field and type in the new value.
14. Click Store calibration  to save the new coefficients. 

Two-point calibration steps on Ruskin
1. Stop the deployment.
2. Download the dataset.
3. Open the dataset on Ruskin. The Properties windows will change to dataset properties, with the Analysis tab 

displayed.
4. Click Calibration. 
5. Select Chlorophyll a  from the dropdown list.

By default, the Number of samples is set to 100, which means Ruskin will average the calibration coefficients 
over a hundred sample points. 

6. Use the up and down arrows to adjust this value. Typically, it should be in the range from 20 to 100 samples, 
depending on the sampling rate. For 16Hz, select 100. For 2Hz, select 20.

The Raw channel box is unchecked, and thus the 
true chlorophyll a values will be displayed in the 
plot below. To see the raw voltage values, check 
this box. 
A downsampled representation of the dataset will 
appear in the thumbnail view, with two distinct 
plateaus corresponding to 0 and 100µg/L.  

Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost 
once your session is closed. 
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7. Check the box next to the first row in the 
calibration table. 

8. Click on a stable point in the Plot view 
corresponding to 0µg/L. 
The interval of samples will be highlighted. The 
average value (Avg) and standard error (Std) for 
this interval will appear in the table above. 

9. Under Real Avg  in the first row, enter 0 and press 
enter. 

10. Repeat the same steps for the second plateau, 
entering 100 under Real Avg.

11. Ruskin automatically calculates the calibration 
coefficients, and the values appear in Calculated 
coefficients. 

12. Click Copy to save the new calibration coefficients to the clipboard, or write them down.
13. In the Navigator view, find your instrument.
14. Click Calibration and select Chlorophyll a  from the dropdown list. 
15. Click C0 to select the entry field and type in the new value (in this example, 557.35712). 
16. Click C1 to select the entry field and type in the new value (in this example, -760.74714).
17. Click Store calibration to save the new coefficients. 

When a two-point calibration is performed 
correctly, residuals will be 0. 

Always click Store calibration to save new coefficients on the instrument. Otherwise, all changes will be lost 
once your session is closed. 
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23 Revision history
Revision No. Release Date Notes

1.0 - H 2011-2020 Various

J 31-August-2022 Restructured the user guide to reflect Ruskin interface, added a 
dedicated page for RSK files, edited existing instructions for 
clarity, removed outdated sections and screenshots. 

K 31-December-2022 Added a section on the Search option under Support (for Mac 
users). Updated the RSK files and File info sections to reflect new 
file structure labels. Added a note in the Gating section. 
Enhanced Plot window instructions.  Updated the Power 
section. Corrected typos in the User calibration section. 

L 31-March-2023 Added/updated screenshots in several sections (Ruskin 
interface, Simulate an instrument, Configuration, and 
Appearance controls) for clarity. Added information on 
synchronising the instrument clock in the Schedule section. 
Added the Connections page. Corrected a typo in the Tide 
section.  Updated the Analysis, Annotation controls, Zoom 
controls, and Automated tasks sections. Added the Utilities 
page.

M 31-May-2023 Added hydrating instructions for the ODO sensor to the 
Dissolved oxygen data collection section. Corrected a typo in the 
ODO calibration in Plot window section. 

N 31-October-2023 Updated the Information section to include guidance on 
downloading the latest calibration certificates. Added UV 
antifouling to Configuration. Clarified the definition of "delay" in 
Valve control. Corrected a typo in Tu data collection. 

P 31-December-2024 Added user calibration instructions for the RBRcoda Tu. 

Q  19-May-2025 Updated pH sensor calibration section with the type of pH 
sensor supported.
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